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Overview
The Navigator (hereafter referred to as “Navigator”) is a comprehensive solution to the management of our
network products, including IP cameras, DVRs/NVRs, and a wide range of applications. Navigator consists of
(1) network video recording software, (2) eMap Manager, (3) Database Manager, (4) Web Server, and (5)
Remote DVR/NVR playback and file download.

Major functions of this software include the management of videos and images recorded by a wide range of
cameras produced by us, recording video clips in the SD card of remote IP cameras and DVRs/NVRs, and
supporting video playback and file download. Navigator can be installed at various sites for camera
management. According to geographical locations and functionalities, the software can also divide IP
cameras and DVRs/NVRs into groups to help users view group images and videos.

eMap Manager is an innovative central management system for live monitoring, alarm snapshots, and map
management. Devices installed at different locations can be displayed and managed with simple clicks on
user-defined maps. One of the many highlights of this function is the dual screen design, which ease the
management of DVRs/NVRs and IP cameras.

Navigator is designed for hybrid installment of IP camera, video server, IP Fast Dome, and DVRs. Its diverse
functions provide the necessary flexibility in managing record storage devices and deliver a comprehensive
solution to digital surveillance. Major features of Navigator are listed as followed.

Navigator Main Features
 Record and manage videos from IP H.264/H265/MJPEG cameras and DVRs/NVRs
 Support up to 108 recording channels.
 Support scheduled, continuous, and motion detection recording
 Support two-way audio and audio recording.
 Integrated alarm output management
 eMap live video with alarm snapshots
 iPhone and Android devices support
 IP Fast Dome control and PTZ control
 Digital zoom, ePTZ, and region of interest (ROI) support
 Support video file conversion to AVI/MP4 format
 Easy-to-use calendar and time selections for video playback
 NAV matrix multi-screen and 2x2 split screen
 User Manager for login, device group, and view group permission management.
 Support P2P NVR remote connection.
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Copyrights
We hold the exclusive ownership of the software and all intellectual property rights embodied therein,
including copyrights and valuable trade secrets incorporated in the software's design and coding methodology.
The software is protected by international treaty. This agreement provides you with only a limited use license,
and does not grant you any intellectual property rights in the software. Adobe and Acrobat Reader are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries. Windows, Windows 2000, Windows XP, Windows Vista, and Windows 7 are registered trademark
of Microsoft Corporation in the United States and other countries.

Before Using Navigator
The Navigator is a video recording application. Although Navigator supports multiple hard drives recording,
when the overwrite setting is enabled, the oldest recorded video clips will be deleted first if the designated
storage is full. Should you want logical partitions in your hard disk drive, allocate at least 60 GB (10%
reserved space) for each drive.

To change the hard drive setting, click System Settings . Select the hard drive(s) to which you want
Navigator to save the recorded videos. It is recommended not to choose the system disk as the destination
drive.

Furthermore, each logical HDD drive should contain at least 10% empty space for storing video data.
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Navigator deletes the oldest files first until it reaches 90% of the logical drive, and it proceeds to the next
logical hard disk drive for recording. It is recommended not to use external hard drives and to opt for hard
drives with a capacity of 500GB or more. Using smaller capacity drives might lead to insufficient space for
overwrite recording, which could affect the recording speed. Please select hard drives with a 7200rpm
rotational speed, as this will be beneficial for writing speed.

Some brands of server hosts may not have a physical graphics card, or the environment does not allow the
connection of a physical monitor. In such cases, as long as your device has HDMI output, you can install an
EDID emulator. This device can simulate the physical monitor Direct3D, and the real-time video will be
displayed normally.

 It is necessary to connect a physical monitor or install a virtual EDID emulator, otherwise Direct3D will
not work normally, resulting in black screens in real-time and playback videos.

 Please do not connect Virtual EDID emulator and external output simultaneously.
 When using a virtual monitor, the built-in or external graphics card must support Direct3D for the EDID

emulator to function.

User Manual
This Navigator user manual is in the PDF format. To access the manual, go to Start→All Programs→
Navigator→User Manual. You must install Acrobat Reader or use Google Chrome for opening the manual.

Uninstall Navigator
To uninstall Navigator, select Start→All Programs→Navigator->Uninstall Navigator. Before you continue, be
sure to back up your database, and you can import the database to the new installation. Please see Database
Manager in this document for details.

Acronym
NCC： Navigator Control Center
VM： View Manager
NAV： Navigator Corporate
PTZ：Pan, tilt, and zoom camera
DVR：Digital video recorder
NVR： Network video recorder
HDD： Hard disk drive
FPS： Frame rate per second
OSD： On-screen display
ANPR： PC based number plate recognition system
LPR：Edge license plate recognition camera

How to Login Navigator
To log into Navigator, open it from the desktop or execute Navigator through the Start menu. For information
security considerations, the first time you log in, a warning window will appear, reminding you to use a
password that meets the required strength to ensure the security of your system. (Please refer to Chapter 1
for creating user accounts and passwords).
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Note: For system default account, enter "admin" and empty as username and password to login.

When logging into the system, a user login dialog box will pop up. Please select "Normal Mode". For
advanced usage, there are other login system modes available, such as LDAP and Active Directory (AD)
modes.

User Account Bookmark
Before logging into the system, there is a user account bookmark feature available for easy and quick access
to switch between accounts. It supports multiple account memory locations and up to 128 groups can be set.

The username and password need to be created in advance by the admin user administrator. (Please see
Chapter 1).

Chapter 1 User Manager
The admin user account has the administrator authority, and can manage various permissions including
camera monitoring, playback, setting and other account permissions.

When logging in as the user administrator for the first time, a security warning will pop up, prompting you to
create a new password.
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For the highest user administrator group, the default account is "admin" and the password is empty.
To strengthen the password security, the following four conditions must be met when creating a password:

Chapter 1.1 Add a User
To add a user, click the Add button. In the Add User Group dialog box, enter the required information.
Remember to choose user access level before you press OK.
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Chapter 1.2 Modify an Existing User
To modify an existing user, choose a user and click the “Modify” button. Here you may change the password
of this user.

Chapter 1.3 Delete a User
To delete a user, choose a user, press “Delete”, and click “OK”.

Chapter 1.4 User Authorization
Features supported by Navigator can be assigned to each user. To enable a feature for a user, click
“Operation”, and check whichever boxes to which you want the user to have access.
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Chapter 1.5 Operation Access Management
Select user type and click on user. Then, click on “Operation” option, please check the required permissions.
Then click on “Save” and “Exit” to save the settings.

Note: Please restart the application settings after closing the Navigator software on the NAV&NCC host.

Function Permission Icons

Navigator eMap Control Center Login Permission

Navigator eMap PTZ Control Control Center Alarm Management

Navigator Database Manager
Control Center Image Decoder
Function

Navigator Local and Remote Playback Control Center Mosaic TVWall

Navigator Video Backup Control Center eMap

Navigator Advanced alarm Management Control Center IPSan

Navigator Camera Setting
Control Center Device Management
Report

Navigator Snapshot Control Station Settings

Navigator PTZ Setting Control View Manager Login Permission

Navigator PTZ Setting Function View Manager System Setting

Navigator System Setting View Manager Remote Playback

Navigator Monitor Matrix Setting
View Manager Synchronous
Playback

Navigator Sequence View Manager Video Backup
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Navigator Right-click Menu Function View Manager PTZ Control

Navigator TV Wall Setting View Manager Sequence

Navigator TV Wall Logout View Manager eMap

Navigator Web Manager View Manager Modify Permissions

Navigator The Software Power Down
import Views for Mosaic TVWall
Feature

- View Manager Alarm Output

- View Manager Snapshot

View Manager Window Close

View Manager Window Minimize

Supplementary Description:
View Manager Modify Permissions

Custom groups cannot be modified or deleted

Locked when dragged to the canvas
(to prevent layout changes).

Unable to switch channels (for example, switching between CH1
and CH2).
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Channel settings restricted, except for audio output.

The View Manager cannot modify or delete image group
arrangement
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Chapter 2 System Settings
In System Settings , you will find a number of tabs that allow you to change the configurations of this
software. Configure the settings to fit your requirements.

 Auto run this application when system starts: Launch Navigator automatically on system startup.
Note: When additional NCC is installed, you can also set the automatic start time from here or
match it with the AI Engine watchdog time.
Startup sequence time specification:
1. NAV > NCC
2. AIEngine = NAV or AIEngine < NAV

 Auto sequence after reboot: Perform group sequential display after a system reboot.
 Original video resolution at full screen mode: Use original video resolution in full screen mode.
 Auto login when system starts: Log in to Navigator automatically when the system starts.
 Force to enter the reason for backup and playback: Check to enter reasons for backup and playback.
 Low latency mode: When CPU load is too high, check this option to make the video smoother.
 Enable “Applications” after reboot: Unique software or custom tools, automatically enabled when the

Navigator main program is opened.
 Snapshot Path: Set the path for snapshot storage.
 Snapshot File Prefix: Add the prefix character of the file name.
 Event Thumbnails: Enable screenshots of alert events, such as: AI license plate, traffic behavior, face

recognition screenshots, etc.
 Synchronize Time with: Automatically synchronize with the computer clock.
 Language: Choose your language from the drop-down list.
 GPU Decode and Display: GPU display decoded output.
 Smart anti-aliasing: Smart channel image edge smoothing.
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 Memory Management: Memory saver management.
 NAV ID： 931 Keyboard ID, default is OFF.
 System Reserved Storage: Click on Circular Recording box to enable, and the maximum hard disk

space can also be set.
 Video Reserved Days: Select the number of days to retain recordings.
 Image Reserved Days: Select the number of days to retain screenshots (Below the snapshot path).
 Raid System Monitor: Can monitor the disk array status, support LSI MegaRAID, Intel® Matrix RAID.
 System Reboot: Check and set the time you want the system to reboot every day.

Note:
1. It is recommended that system drive is not set as video destination drive.
2. Snapshot Path Please specify C: Drive other than the system hard drive and create a new folder for
alarm snapshot storage.
3. Snapshot Path is in C drive and does not support alarm screenshot function. Attention!

Chapter 3 Programming Tool
Provide unique software tools, users can decide whether to automatically enable below functions after the
Navigator main program is turned on.

 Navigator TVWall 64 bits：Video decoder can be used as a virtual matrix system in large monitoring
systems (Virtual Matrix System); Check on “NAV NETStreamingType” box, you can pull the
Navigator image directly into the group for monitoring and construct the entire large surveillance TV
wall. When Navigator is opened, video decoder TVWall will be enabled automatically.

 Navigator Archive Manager：You can back-up the PC image of Navigator Software to the network
storage device. When Navigator is opened and this option is enabled, the archive manager will be
automatically opened.

 NAV QRCode Decoder Server：A new program will be launched soon. When Navigator is turned on and
this option is enabled, the QRCode server will be automatically connected.

 USB Scanner Tool：Handheld scanners support 1D and 2D barcodes, and bring more rapid productivity
and performance to the retail industry. They are suitable for a wide range of applications in retail,
healthcare and post offices. When you open Navigator and check this option will USB Scanner
Toolautomatically.

 Navigator eMAP Manager：When you open Navigator and this option is checked, the eMAP Manager will
be automatically enabled.

 Recording health Checker： If the power is off due to abnormal power failure, the image may not be
stored or the data may be damaged. If this option is checked, the recording health checker tool will be
automatically enabled. Support manual custom time check and generate health status report

 NCC：When opening Navigator, check this option will automatically activate Navigator Control Center.
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 Start Year：Check start time year/month/day.
 End Year： Check endtime year/month/day
 Low CPU Usage Mode：Scan all, regardless of whether there are files in the video file folder or not.
 Make Daily Report：Provide a report after the scan is completed

Chapter 3.1 GPU Graphics Decode Setting
With hardware advancement in high-resolution videos, in addition to bringing better picture quality, it also
brings more CPU usage. The GPU decoding method enables the system to perform multitasking operations
while viewing CCTV. At present, GPU decoding supports NVIDIA 1030-level graphics cards and Intel®
530-level built-in displays. It also supports GPU hardware decoding functions for both NVIDIA graphics cards
and built-in Intel displays. When the host has both NVIDIA graphics cards and motherboard Intel® built-in,
Navigator optimizes resources based on system usage to achieve more channels or high-frame devices.

 Turn Off Graphics Hardware Acceleration
Turn off Direct3D software decode acceleration, GDI traditional graphics mode display, and support
old type without Direct3D graphic card.

 Graphics Hardware Acceleration Display(Default)
Turn on CPU software decode acceleration, Direct3D graphic mode display, and supports new
Direct3D graphic card.

 GPU Decode And Display, Display High Priority
Turn on GPU hardware decode acceleration, graphic display is prioritized.

 GPU Decode And Display, Decode High Priority
Turn on GPU hardware decode acceleration, decode display is prioritized.

Note: If a user purchased a new NVIDIA graphics card, they need to update to the latest version of Windows
10. Please note that not all versions can be directly upgraded to the latest one. If Windows Update does not
provide the latest version continuously, it is recommended to seek technical assistance from the original
manufacturer to reinstall the latest operating system version.
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Note: Standard Video Display Card with Windows Version

NVIDIA Chip Architecture Windows 10&11 NVIDIA Display Card Model (Support super*Ti)

Pascal Architecture
Graphics Card Version 1607 or later 10 Series:GT1030,GTX1050,GTX1060,GTX1070,

GTX1080,TITAN X/XP

Turing Architecture
Graphics Card Version 1709 or later

16 Series:GTX1650&1660

20 Series:RTX2060&2070&2080,Titan RT

Quadro Series:RTX 4000,5000,6000,8000

Tesla Series: Tesla T4

Ampere Architecture Graphics
Card

Version 1803 or later 30 Series:RTX 3050,3060,3070,3080,3090

Ada Lovelace Graphics Card Version 22H2 40 Series: RTX 4060,4070,4080,4090

Note: If you want to experience more real-time video channels and high-definition video cameras, please
upgrade your graphics card and physical memory. The recommended NVIDIA graphics card memory is 4GB
or more, and recommended physical memory is 32GB or more.

Chapter 3.2 Memory Protection and Watchdog Setting
When a computer system has multiple programs running at the same time, the system often divides the main
memory into several areas and assigns them to each program. In order to avoid mutual interference when the
program is running, the Navigator watchdog memory protection control mode must be used to limit the activity
in the memory area of each program. This is the memory protection.
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Memory Protection Setting:

 System memory use limit: preset is 80%
 “Navigator 64 Bits” memory use limit: NVR Software preset max limit is 4096MB.
 “Navigator MStreaming Server 64Bits” memory use limit: Streaming Server, preset max limit 2048MB.
 “Navigator Archive Manager 64Bits” memory use limit: Archive Manager, preset max limit 2048MB.
 “Navigator eMap Manager 64Bits” memory use limit: eMap, preset max limit 2048MB.
 Restart the power after restarts the software repeatedly: restart the computer after repeated back-end AI

Engine server disconnection detections.

Watchdog detection reopening mechanism:

 Instant：When the system detects an abnormality, the software restarts immediately.
 Reboot at system reboot time: When the system detects an abnormality, the software automatically

restarts at preset 00:00 night time.

Host status database

 Limit max CPU usage: Set CPU usage to 80%
 Disk queue length limit: preset limit5 counts
 Disk response time limit: preset max limit200ms
 Disk active time percentage limit: preset max limit 85%
 Network packets output queue length limit: preset max limit 2 packets
 Network IO throughput limit: preset max limit 70%
 “Navigator Playback Manager 64 Bits”: preset max limit 2048MB.
 “Navigator Remote Playback Manager 64 Bits”: preset max limit 2048MB.

Note： When the system detects an abnormality 3 times consecutively, and still detected within 10 minutes,
the computer will restart.

Chapter 3.3 Database Management
When NCC is not the big data central control host, please disable sending the screenshots and AI information
from the NAV database management to NCC to prevent NCC from receiving a large amount of information
that could lead to database crashes.
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Chapter 4 Navigator Login
From the Navigator main menu, please click on desktop button to access the Navigator monitoring
screen.

Chapter 4.1 How to Add a Device to Navigator
The Navigator supports IPScan protocol. IPScan protocol is convenient for discovery of NAV, NVR/DVR, and
IP cameras in the network.

Chapter 4.1.1 Add a New Device
To add a new device, select any channel and click the “Properties” icon . Click the “Find Device” button to
open IPScan, a tool that helps you find all devices in your network. Choose the device you want to use and
press “Close”, and you will see a prompt window asking “Do you want to auto set the IP/DNS and the host
post?” Click “Yes”, and the application will automatically complete all the settings for you.
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The configurable settings in Properties are listed as followed:

 Find device: IPScan scans IP network area, all Navigator/DVR/NVR/IPCAM and other devices.
 Video: After inputting device IP setting, click on “Video” to see the live image preview.
 Activate this device: Check or uncheck to enable or disable the camera.
 Name: Camera name displayed on top of the live video channel.
 Location: Location of the camera installed.
 Device type: Please select "IP Camera" for the camera, select "DVR/NVR-H.264" for DVR/NVR

device, or click "Detect" to automatically adjust the settings..
 ONVIF: Most of the ONVIF devices are communicated via HTTP port 80. If the target ONVIF is not

communicated by HTTP port 80, our NAV recorder provides extra ONVIF port for communication
purposes.

 Streaming Mode: It can select single or dual stream output with two different bit rate image.
 Record mode: It can select main stream/sub stream recording or dual stream, and low bitrate

recording mode.
 Assign recording mode: Assign different hard disk for recording, channel distribution mode

recording.
 IP/DNS (required): IP address of the device.
 HTTP Port: HTTP port number of the device.
 Video Port: DVR’s video port number/IP camera’s RTSP port number.
 Username
 Password
 Image size: The source video size of the device.
 Camera/485 ID: IP Fast Dome RS-485 ID.
 Synchronize Time with PC: Synchronize time with the local PC.
 Low Bitrate client server connection: When check, save live image bandwidth of IP channel

connected to HTTP Port.
 Alarm Management: Adjust input and output for alarm management setting.
 ePOS/OSD: Set up connected ePOS/OSD device.
 ANPR Group Setting: Can add license plate’s allowed list and denial list.
 Object counting: Set up object counting function.
 Facial recognition: When a face is detected, will take screenshot of detected face.
 Reboot device: Re-start the device.
 Launch browser: Device web page setting.

Note: RS-485 camera ID (1 to 128) must match the ID setting of the IP Fast Dome. The software may not
control the PTZ movement if the ID setting is incorrect.

Once you complete the above settings, youcan click on “Video” to test if the device is working properly. For
information of the default username and password, please see Appendix for details.

Chapter 4.2 Set up Hard Disk Recording
When the system is a non-RAID hard disk, you can select different channels to record on other hard disks.
The purpose is to reduce the recording load of a single hard disk, or to save video of important channels.

Note: By default, the system will only move on to the next disk after the disk recording space is full.
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Chapter 4.3 Device Type
For video streaming, there are several device types to choose from:

Device Type Description

H.264 AVC IP Mini Dome D1 H.264 IP PTZ camera stream

IP Camera IP Camera with H.264/H.265 stream

DVR/NVR-JPEG DVR/NVR low bandwidth snapshot stream

DVR/NVR-H.264 DVR/NVR H.264 stream

DVR 2B/2C Series DVR 2B/2C series stream

AHD/DHD Series AHD/DHD DVR series stream

Third-Party AHD/DHD Series Other brand AHD/DHD DVR series stream

NAV Live Streaming NAV live image streaming

NAV USB/P2P Live Streaming USB camera or NAV P2P live streaming

NAV-JPEG NAV JPEG stream

NAV-JPEG Poster NAV-JPEG Poster

Low Bitrate IP Camera Low bandwidth I frame camera connection

Low Bitrate DVR Camera Low bandwidth I frame NVR/DVR camera connection

Snapshot Device Low bandwidth JPEG snapshot stream

Manual Manual input of camera URL stream

Third-Party ONVIF Camera Other brand ONVIF protocol stream

Manual RTSP RTSP image stream

Screen Capture Screen capture streaming features

IPCamera HTTPS IPCamera HTTPS series streaming

NVR/DVR-H264 HTTPS NVR/DVR-H264 HTTPS series streaming

Multi-Sensor IP Camera Multi-Sensor streaming

Third-Party DVR/NVR Other brand DVR/NVR series models streaming

Chapter 4.3.1 NAV IPCAM HTTPS Connection Method
1. IPCAM IE Web Login
Network-> HTTPS Service ->-> Check “Enable”->Create a certificate
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2. NAV IPCAM HTTPS Connection Method
Camera Settings->Device Type ->IPCam HTTPS

Chapter 4.4 ONVIF Settings
To use RTSP streaming, first you need to set up the ONVIF protocol:

 Codec: H.264&H.265 mode, JPEG mode.
 Resolution: Live image picture resolution.
 Profile: A user can select different streaming profiles such as H.264&H.265 1080p/480p or MJPEG

480p/CIF.
 Protocol: Streaming protocol such as RTP/UDP, RTP/TCP, or RTP/TCP/HTTP.
 Frame rate: Live image frame rate.
 Bitrate : Image transmission bitrate.
 Quality: Live image picture quality.
 RTSP Keep Alive: The function derived from the disconnection of the traditional type cameras (the

current default does not need to be checked).

Note: ONVIF settings are only available for our ONVIF camera.
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Chapter 4.4.1 NVR/DVR P2P Connection
To use the NVR P2P connection, open the NAV camera setting option, select "NAV USB/P2P Live Stream,"
open NVR/DVR -> Network settings, and paste or enter the P2P account into the NAV P2P ID option.

1. P2P Account Number
2. Username and Password

Chapter 4.5 Find Device
IPScan utility can scan through all IP address in the LAN to locate devices.

Select a device in IPScan and click “Close” to set up the device. All the device information such as IP address
and port number will be automatically detected by Navigator.

You can also manually add devices of IP Fast Dome, IP camera, video server, or DVR .

Note: IPScan can only work under a LAN environment and does not support an Internet environment.
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Chapter 4.5.1 How to Change Device Names in IPSCAN
Search for the desired device and mouse click on it. After the selected state appears, enter a new name for
the device, tick on "Authentication" box and enter the account username and password to apply. The device
name should be updated afterwards.

Chapter 4.5.2 Change the Device IP/HTTP/HTTPS Port Number in IPSCAN
Search for the desired device and mouse click on it. After the selected state appears, please modify the IP
address, subnet mask, gateway, and HTTP/HTTPS port. Tick on "Authentication" box and enter the account
username and password to apply. The device IP address should be updated afterwards.
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Chapter 4.5.3 Update Device Firmware in IPSCAN
Search for the desired device and mouse click on it. After the selected state appears, click on “Firmware
Update” and wait for 30 seconds or more until a message displayed update is successful.

 Use Encrypt File: Whether to select the encrypted firmware. (Please refer to the device provided
encrypted firmware version.

 Device type:
 Camera: Camera firmware.
 AI: Edge front-end camera firmware.
 Configure Parameter: Export camera settings.

Chapter 4.5.4 Batch IP Setting in IPSCAN
Search for the desired device, press “CTRL” on the keyboard to select the N devices, click on “Batch IP
Setting”, and wait for 30 seconds or more until a message displayed update is successful.

 DHCP: Automatically assign a dynamic IP address.
 Assign Username and Password At First Time Out of Box: The account password of the device is

restored to its initial value.
 Login the Device after Password Creation: Enable the camera authentication.
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Chapter 4.5.5 Restore a Device to its Default Settings in IPSCAN
Search for the desired device and mouse click on it. After the selected state appears, click on “Set as Default”,
and wait for 30 seconds or more until a message displayed update is successful.

Chapter 4.5.6 Enable or Disable the SDDP Function in IPSCAN
Search for the desired device and mouse click on it. After the selected state appears, click on “SDDP”, and
wait for 30 seconds or more until a message displayed update is successful.

Chapter 4.6 Alarm Input Management
Navigator supports a wide range of alarm inputs, which may be different according to various camera models:
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Alarm input management Description

Remote Alarm In If the camera supports digital input, once triggered, Navigator shall be
notified.

Remote Motion/Tripwire Detection If camera supports motion/tripwire detection, once triggered,
Navigator shall be notified.

Remote Face Detection If camera supports face detection, once triggered, Navigator shall be
notified.

Remote Tamper Detection If camera supports tamper detection, once triggered, Navigator shall
be notified.

Remote Audio Detection If camera supports audio detection, once triggered, Navigator shall be
notified.

External IO device If external IO is use, Navigator shall be notified.

Motion Detection This is local Navigator motion detection setting.

Nav CGI Triggering Navigator CGI triggering

Video Loss Detection The navigator image has no signal detected, if channel suddenly
video loss, navigator shall be notified.

License Plate Recognition

Detection
Navigator AI license plate recognition detection, once the Navigator is
triggered, there will be a license plate recognition OSD notification.

Remote LPR Detection Navigator remote license plate recognition detection, once triggered,
navigator will have license plate recognition OSD notification.

Face Recognition Detection Navigator face recognition detection, once triggered, navigator will
have face recognition OSD notification.

QRCode Detection Navigator QRCode detection, once the Navigator is triggered, there
will be QRCode OSD notification

AI Behavior Detection Navigator AI traffic behavior and object detection, once the Navigator
is triggered, there will be traffic behavior alert notifications.

Chapter 4.6.1 Remote IP camera with digital I/O
If the IP camera is equipped with a DI/DO interface, enable "Remote Alarm Input" in the alarm input list, and
then check "Enable Alarm Input" to trigger the IP camera digital output.

Chapter 4.7 Alarm Output Management
The alarm output function supports a variety of different alarm responses, which can be used for motion and
remote motion alarm detection management. The alarms that can be triggered may vary depending on the
camera model.
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Alarm Output Management Description

Play Sound When an alarm triggers or an event occurs, a user defined wav
audio file will be played.

Send Email Send email notification

PTZ Preset Recall Set PTZ to move to preset position

Signal Digital Output Send IPC digital output

Alarm Full Screen When alarm triggered or an event occurs, the channel is
displayed in full screen.

Post-alarm Record After alarm occurs, will record for 5 seconds.

Pre-alarm Record Before alarm occurs, will record for 1~10 seconds.

Advanced Alarm DO Turn on DO device, i.e. IP Camera’s DO, MOXA 1200 Series

Alarm ACK Alarm acknowledgement after the alarm occurs, if the user has
two monitors, it will automatically pop up.

Alarm Snapshot Alarm snapshot

Text Overlay Users can custom input Chinese and English special symbols
displayed in the channel screen

App Cloud Push Notification When an alarm triggers or an event occurs, navigator will send
push notification to mobile app.

NCC TVWall ACK NCC Mosaic TVWall ACK Alarm confirmation function

NCC Emap Center Alarm NCC Emap Center eMap control alarm trigger

NCC Play Audio View Manager trigger the alert sound after the alarm is set off

NCC Global Alarm Settings NCC Global alarm system triggered at the same time

Chapter 4.7.1 Advanced Alarm DO
You can set IP Camera’s DO and MOXA Uport on advanced alarm outputs, triggering warning lights or
buzzers and gate control switches.

Chapter 5 MOXA-ioLogik-E1212Control Box
The ioLogik E1200 industrial Ethernet remote I/O has two embedded Ethernet switch ports that allow
information to flow to another local Ethernet device or connect to the next ioLogik in the daisy-chain.
Applications such as factory automation, security and surveillance systems, and tunnel monitoring, can make
use of daisy-chained Ethernet for building multi-drop I/O networks over standard Ethernet cables.

Attention! MOXA control box with Navigator software is only up to version 3.0.0.170. Please contact
technical support team for further support.
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Note: The Reset button restarts the server and resets all settings back to factory default. Use a sharp object,
such as a straightened paper clip, and press down the RESET button for 5 seconds. Once the READY LED
turns green again, the factory defaults will be loaded. Then you can release the RESET button

Chapter 5.1 MOXA General Settings
In General Settings page, you can specify the server name and location to help you distinguish between
different ioLogik E1200 devices. You can also configure the Modbus / TCP timeout interval or enable
communication watchdog function.

Chapter 5.2 MOXA Ethernet Configuration
In Ethernet Configuration page, you can set a static or dynamic IP address for the ioLogik E1200 and
configure subnet masks and gateway addresses.

Chapter 5.3 MOXA Web Console IO Setting
The status of each DI (digital input) channel appears on the DI channel setup page.
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Chapter 6 IP Camera IE Webpage IVS Tripwire Detection
In IP camera web page settings, please go to Advanced mode”→ IVS→ Advanced Tripwire Detection

1. Enable the Advanced Tripwire Detection to edit, and then set the tripwire area.
2. When an object passes the tripwire, it will trigger, and the tripwire will change from green to red.

Chapter 6.1 Navigator Alarm Management Settings
1. Select IVS Camera Channel →Right mouse click→”Camera Properties”.
2. In Camera Setting Page, press“Alarm Management”.
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3. Alarm Input Management →Check “Remote IVS (Motion) Detection”, Check at least one alarm output,
For example:“Post Alarm Record”, if you need MOXA DO action, then check “Advanced Alarm DO”
and “Options”.

4. Press “Device Scan”→MOXA Device Connection

Note: The position of DO and MOXA box must correspond to each other to have normal DO output.

Chapter 6.2 External IO device
1. Please check “External IO Device” → “Options” → Select Device Type “MOXA 12XX” → “Device Scan”
2. Press “Device Scan” → MOXA Device Connection

Note: DI stands for MOXA switch device.

Chapter 6.3 Alarm Acknowledgment
You need two monitors to enable alarm acknowledgment, one for Navigator and the other for alarm
acknowledgment. Click the Monitor Setting icon and set the Alarm ACK Monitor to the second monitor.
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Navigator main monitor Alarm acknowledgement monitor

Video is displayed on the Navigator alarm acknowledgement monitor you designated. To acknowledge the
alarm, click the ACK OFF button at the bottom left corner of the Navigator alarm acknowledge monitor.

To setup the acknowledgement feature, check Alarm ACK in the alarm output list.

Chapter 6.4 Notify Navigator Installed on Other Computers
Third-party software can enable or disable videos on the alarm acknowledge monitor using the CGI
commands provided by Navigator. See HTTPAPI.PDF on our official website for more details.

Chapter 7 Recording Settings
By default, Navigator starts continuous recording after an IP camera is connected. To change recording
configurations, please read the following sections.

Chapter 7.1 Schedule Recording Settings
The recording schedule of Navigator can be set to Always, No Record, and Motion, and the time increment
can be set down to an hour. To designate which hours to record, first choose the recording type (Always, No
Record, and Motion), and then highlight as many boxes as you like in “System Settings”→”Schedule”.

Click Apply next to Apply All Schedule to apply the selected recording type to all days and hours. To apply a
recording type to all channels, click “Apply All” for apply schedule to all channels.
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Chapter 7.2 Motion Detection Recording
To enable motion detection recording, click to open the Properties dialog box. Next, click Alarm
Management and check Remote Motion Detection. Click Options to configure the settings. Navigator provides
up to four user-configurable motion detection areas. Simply drag across any areas on the screen to define a
motion detection area. Right-click to clear one or all designated areas. To adjust motion detection sensitivity,
use the scroll bar at the bottom of the window. Motions that are detected within the highlighted areas will send
an alarm to the system. Click Apply for the settings to take effect.

In the live monitoring mode, a “yellow man” appears in the channel if any motion events are detected.

Note: The use of remote motion detection can further reduce the CPU load of a Navigator PC, for this function
utilizes the motion detection engine of the IP camera.
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Chapter 7.3 Recording at System Startup
Check this option to start recording automatically every time you boot the system. It is not required to start
recording manually. If a schedule is set, Navigator will begin recording according to the schedule at startup.

Chapter 7.4 Estimated Recording Days
To estimate the remaining storage capacity (days), a user can click System Setting and switch to the Record
Time tab. Estimated recording day and time information will be displayed on the right side of the pane.

 Total Recording HDDs: Recording sector is checked.
 Available Recording Space: Total hard disk capacity minus the reserved space for loop recording

(ie:873994MB/854G).
 Remaining Recording Space: The remaining recording space of the hard disk (ie:128MB/0G)。
 Average Frame Size: Hard disk recording data (ie:2323KB/Sec)。
 Total Recording Time: Recordable space ÷ average recording flow = total recording time

(days/hours/minutes)
 Remaining Recording Time: Remaining recording space ÷ average recording flow = remaining

recording time (days/hours/minutes)。
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Chapter 7.5 Network Storage NAS
You are allowed to save recorded files on network storage such as iSCSI or NAS if the network storage
supports “Network Neighborhood” protocol.

To do so, go to the Network tab. Click Add Network Drive, and select any network storage by clicking Mapped
Drive of Navigator Software PC. Choose Apply when the network storage is selected. Check the storage you
just added at the bottom of this window. Navigator will begin circular recording and save the files to the drive
you selected.

Otherwise, you can go to My Computer→Tools→Map Network Drive. Please make sure that the Reconnect at
logon option is checked to avoid losing connectivity.
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Chapter 8 Group Settings
Chapter 8.1 Grouping
Users are allowed to divide cameras or DVRs into groups based on their geographic locations or functions.
You can easily view the videos recorded by the grouped devices. To create groups, enter System Settings and
click Grouping and follow the followings steps:

1. Select a group type from the left pane and click the Right Arrow to create a group.
2. Click OK to save the settings.

Chapter 8.2 Group Naming
To name a group, right-click a group and select “Property”. Enter the name you want to use into the text field.

Note: Main grouping is system default name and cannot be modified.

Chapter 8.3 Auto add Devices in a Group
For saving time and convenient operation, user can automatically import IP Camera, DVR and other multiple
devices in each grouping by clicking “Add Camera”. Each group supports 36 devices.
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Chapter 8.4 Quickly Add device
After clicking on “Add Camera”, and IP auto search is finished, you can quickly find the desired device by
selecting Scan Device Type.

Auto detect Onvif device connection status. If the connection fails, it instantly correct account password and
network port. Manually press “Onvif” will detect the connection again.

After confirming the device is connected, the devices listed above can be imported into the specified group.
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Chapter 8.4.1 Add an NVR or NAV Host
The maximum limit for each group on the NAV host is 36 channels. When importing remote devices, you can
choose to import the first half or the second half of the devices.

Chapter 8.5 Group Authentication
To assign access rights to particular users, please check Device checkbox to allow access to groups or
channels. The default setting allows every user full access to every device in the group. Group access rights
also apply to web servers. Users with different access levels can only see the videos of their corresponding
groups.

Chapter 8.6 User Authentication
To assign access rights to particular users, please check Operation checkbox to allow access to groups or
channels. The default setting allows every user full access to every device in the group. Group access rights
also apply to web servers. Users with different access levels can only see the videos of their corresponding
groups.
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Chapter 8.7 View a Group
To view the videos of a group, click “Groupings” and chose the group you want to see.

Chapter 8.8 Group Sequential Playback
To adjust the group sequential playback interval (seconds), go to the Grouping tab in System Settings.

Chapter 8.9 Main Grouping
Main Grouping is a group consisting of 36 devices, which are displayed in a split view in Navigator. To add a
device to the main grouping, please follow these steps:

1. Select Main Grouping in grouping dropdown list.
2. Right-click one of the cameras.
3. Select Properties.

Chapter 8.10 Split View
Currently, Navigator supports four types of split views including full screen view, 4-channel view, 16-channel
view, and 36-channel view. To open the full screen view, double-click a camera to maximize the screen. Click
Windows, and choose the type of view you want to see.

Chapter 8.11 Dynamic Video Channel Swapping
If you want to move a camera channel around, you can simply drag a camera to another video channel. This
operation swaps these two cameras’ positions dynamically in the software. For users who want to adjust the
display position after site installation, they do not need to re-assign the IP settings.
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Chapter 8.12 Digital Zoom
To zoom in a specific area, click and drag to create an area for digital zoom. Then you can move the zoom-in
area (green area) at will.

The digital zoom function is also available in the playback mode.

Chapter 9 Playback in Navigator
Navigator can playback the videos recorded by all IP-based products including H.264/H.265 HD IP Cameras,
Full D1 IP Cameras, IP Fast Domes, Video Servers, LAN Cameras, and DVRs.

Chapter 9.1 Playback
First of all, select a camera channel or a DVR. Press the Playback icon , and choose Playback

. A new window will open.
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Chapter 9.2 Playback for an IP Camera Within the MainGrouping
Video recorded in the main grouping can be saved to a local PC. Stored video clips can be played by
specified date and time. To do so, follow below steps:

1. Choose a date in the calendar.
2. Specify the starting time and ending time.
3. Click “Search” to search the video clips.

When a video clip is playing, click Stop , Play , Pause , << (Rewind) , >> (Fast Forward) , and
Snapshot icons to perform the corresponding function. You can also click the time-bar or drag the
scrollbar to jump to a specific time.

 White: No recording or device disconnected.
 Purple: Continuous recording.
 Yellow gradually turns green：Alarm event recording, the color frequency range is 1~10. As events

become more frequent, the color gradually becomes greener.

Chapter 9.3 Multi-Channel Playback
You can choose a group for multi-channel playback. Just click the multi-channel playback icon , and a
playback window appears as below:
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Navigator supports up to 36-channel playback at the same time.A number of settings can be changed for
multi-channel playback: (1) NAV/CMX I frame only (2) I frame only. I frame only is only available when
multi-channel playback is activated, and activate this option will force Navigator to show only 1 frame/sec in
the background to reduce CPU load. For less powerful workstations, we suggest you activate this option.
However, you may uncheck the option if CPU usage is low.

Chapter 9.4 Remote Multi-Channel Playback
You may also connect to another Navigator host remotely and play videos saved on that host. To enable
remote playback, click Playback, then select Remote Playback . Click the Connect button
and enter IP/DNS address, port number, username, and password to access Navigator. Select a group for
multi-channel playback. Moreover, you can add Navigator hosts as bookmarks to instant login in the future.

Chapter 9.5 Remote DVR/NVR Playback
For playback videos on a remote DVR/NVR, right-click the DVR/NVR channel and select DVR/NVR Remote
Playback.
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Then you will see the DVR/NVR Playback dialog box. Specify the date and time information in the dialog box
to start remote DVR/NVR playback.

Chapter 9.6 SmartSearch
SmartSearch is available in multi-channel playback. This search function provides quick video search in
selected motion detection zones.

To perform SmartSearch, enable full screen mode for a particular camera. Select SmartSearch in the
drop-down list of Select Mode and press Search. A SmartSearch dialog box will appear. Drag the motion
detection area on the screen inside the SmartSearch dialog box. Click Start, and the system automatically
performs a quick scan for any signs of motion activities in the video clip.

In the event list, snapshots of the motion activities will be displayed. Click on the snapshots to jump to the time
when a particular event happened.

Chapter 9.7 AVI File Export & Play from a File
Chapter 9.7.1 Export AVI with OSD
Users are allowed to export an AVI file recorded by a main grouping device. First you need to open the
playback interface and search for a recorded video. Click the Backup button, choose Destination Directory,
and press Convert AVI with OSD on the right side of the screen to export the AVI file.
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Chapter 9.7.2 Export AVI without OSD
Export an H.264 AVI file without an OSD timestamp can be much faster than rendering an AVI file with a
timestamp.

Navigator stores its video clips in a GUID folder inside the default Video folder. The GUID folder is named by a
32-digit hex string. The videos are saved under year, month, day, hour, and minute.

Note: As the OSD file is too large and it takes a long time to backup, OSD backup AVI supports maximum of
1920 x 1080 resolution only.

Chapter 9.8 Multi-Channel Backup
Multi-channel backup features (1) multiple channel playback through MPlayer, which is a comprehensive
media player; and (2) AVI backup for multiple channels.

To back up your files, click the Backup icon and select channels. Specify the date, time, and destination
directory. Finally, choose Start Backup or Covert AVI for multi-channel video backup to begin.

Chapter 9.9 Snapshot
In a system consisting of IP based services, you may want to capture images in a particular video. You can
utilize this function in Navigator by simply clicking the Snapshot icon . The picture will be saved as a JPEG
file.



45 66-UM-NAV5.0-OE-9

Chapter 9.10 Alarm Event Playback
To playback motion detection events, choose Alarm in the Select mode drop-down list, and click Search to
display all motion detection events. Click any of the events to play associated videos.

Chapter 9.11 Tagging
To tag important video clips, click “Tagging” to tag the video. The tagged time video clip will be retained
even when have exceeds recycle recording number of days.

Select “Tagging” to playback event and you can playback important clips. If you don't want to occupy
recording space, right click → “Clear” or “Clear All” tagged time in the tag period.

Chapter 10 Audio
Chapter 10.1 Two-way Audio
Navigator supports two-way audio enabled surveillance cameras. To activate this feature, select a particular
channel and click the Speaker icon at the top-right corner to listen to the audio of the channel. You can
also move the volume bar to adjust the volume. To speak to a remote site, please click the Microphone icon
next to the speaker icon.

NOTE: Audio monitoring is only available in the full screen mode. Double-click a channel to enter the full
screen mode.
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Chapter 10.2 Two-way Audio Auto Switching
Navigator supports two-way audio for IP cameras. Check Audio Auto Switch in Properties will
automatically enable audio and microphone feature when the camera is switched back and forth.

Chapter 10.3 Audio Recording
Navigator supports audio recording using IP camera models equipped with audio input. The Playback
interface can play audio (if any) simultaneously with the recorded video.

Chapter 11 Archive Manager
Archive Manager, a built-in feature in every copy of Navigator, can archive videos to a central network storage
device. Archive Manager delivers a hassle-free experience that automatically saves your video clips to a
secure location. To open Archive Manager, please go to Start→ All Programs→Navigator→ Archive Manager.

Chapter 11.1 Archive Source
To start video archiving, select the cameras you want to archive. You can either keep the video clips in the
local PC (duplicate archiving), move the local data to a remote archive destination, or stop archiving for a
specific time frame. After the configuration is completed, you can schedule the archive task by choosing the
hours and days you want the archiving to take place. Also, you can apply all settings to the schedules of other
cameras.

Chapter 11.2 Archive Destination
You can choose the Archive Drive where video clips will be archived. The Archive Drive could either be a
network RAID drive or an internal SATA RAID for large data storage. To choose a NAS RAID as the archive
destination, click Setup Network Disk to mount a remote drive to Navigator. After the disk is chosen, select
Real-Time Archiving or Scheduled Archiving. The former will start archiving immediately the next minute, and
the latter will start archiving in the designated time.

Chapter 11.3 Synchronization
NAV recorded file sync

 Data overwrite: The system obtains the image data from the device and overwritten back to the NAV
recording host.

 Data no overwrite: The system checks for missing video clip but does not overwrite.
 Data recovery: The remote server has a storage device in IP Camera SD card. When the network is
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disconnected, it will recover disconnected portion from the SD card.

Note:When the device is disconnected, it can also pass through the storage device. For example: IP camera
SD card for backup to the Navigator host

Note: Synchronized devices can have up to 1 channel at a time. When the network or remote device is
backed up for too long, another channel will be back up after the maximum time of 1 hour is reached, until all
channel sequences are completed.

Chapter 11.4 Back up Log
After completing the above steps, you can see the synchronized information in the Archive log.
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Chapter 12 PTZ Control Panel
In Navigator, you are able to control the movements of PTZ cameras. Select the channel of a PTZ camera
(e.g., IP Fast Dome) and click PTZ Setting to control the movements freely using a PC keyboard and/or
the PTZ control panel

Chapter 12.1 Preset Point Settings
To set up preset points, please invoke Presets dialog box. Follow the following steps:

1. Select preset point dropdown list.
2. Type the time field.
3. Type the speed field.
4. Click up, down, left, or right to move the IP Fast Dome to specific position.
5. Click Apply button to set the position.

Chapter 12.1.1 PTZ Control Panel Instructions

Icon Function Description

Direction Button
Rotate the PTZ to 8 different directions including up
and down, left and right, upper right and lower right,
upper left and lower left.

Moving Speed Select to adjust the speed of PTZ rotation (up to 7x).

Device Type Select supported camera device type, ePTZ, PTZ,
auto focus, Fish Eye.

Preset Recall Up to 4 preset points can be recall instantly.

PTZ Preset Point Up to 128 preset points can be programmed.

Zoom+/- Adjust digital zoom in/out.

PTZ Auto Pan Enable Auto Pan, Disable Auto Pan

Auto Focus Manual Focus +/- , Auto Focus AF

Auto Iris Manual Iris Far/Near, Auto Iris

Preset Point Setting Set auto pan preset positions.
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Chapter 12.2 On-screen PTZ Control
In full screen mode, click on on-screen control icon that can enable PTZ control by using a mouse. Use
mouse scroll wheel for PTZ zoom in and zoom out.

Chapter 12.2.1 Control PTZ via a Mouse
In full-screen mode, click the PTZ control button to control the PTZ on the screen. After enabling the mouse
PTZ mode, use the mouse scroll wheel to zoom in and out the PTZ.
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Chapter 12.3 On-screen Panoramic Camera Control
In full screen mode, click on on-screen control icon to enable panoramic camera control by using a
mouse. Use mouse scroll wheel for camera zoom in and zoom out.

Drag the window at the panoramic view to adjust the ROI window. There are three mount types available -
ceiling mount, wall mount, and desk mount.

Chapter 12.3.1 Fisheye Control Panel Instructions (Ceiling Mount, Table Mount)

Icon Function Description

Location Location: Ceiling Mount, Table Mount, Wall Mount

R Mode Full-screen panoramic view

3R1O Mode Three ROI views and one panoramic view

Click the window to control
Use themousewheel to zoomin and out

ROIWindow
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4R Mode Four ROI views

2R1P Mode One panoramic view and two ROI views

2P mode Two 180 degree views

8R1O Mode One panoramic view and eight ROI views

Preset Point Setting Provide up to 128 preset points storage.

Chapter 12.3.2 Wall Mount Installation
The wall mount mode is different in some split screens and angles, please refer to the following.

Icon Function Description

2R1P Mode One180 degree view and two ROI views

1WP Mode One wall mount 180 degree view

Chapter 12.4 Navigator Status Panel

Chapter 12.5 Control PTZ via our 3D Keyboard
Many Navigator functions can be activated with our 3D keyboards. Connect our 3D keyboard to a Navigator
host through an RS-232<->RS-485 adapter.

First, enter the DVR/NVR control mode by pressing SHIFT and DVR.

+

To use Navigator features, simultaneously press Navigator ID, DVR, and ENT.

+ +
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To select a group, press and hold the monitor ID and MON before pressing the group ID and PRESET.

+ + +

Chapter 12.6 Split View
To switch split views, launch Navigator and press the following icons:

16-channel 8-channel Navigator ID+ DVR+ENT 36-channel

9-channel 4-channel

To enter the 36-channel view, simultaneously press the Navigator ID, DVR, and ENT. The operation is the
same as operating a Navigator host.

Chapter 12.7 Control a Camera
For control a camera, simultaneously press the camera number and CAM buttons.
Example: Control camera #8

+ +

PTZ and Lens control

Chapter 12.8 IP Camera ePTZ or ROI Feature
Several models of IP cameras provide ePTZ or ROI features. With the help of Navigator, you can use a
keyboard controller to access ePTZ or ROI feature.

Chapter 12.9 Switch between Navigator and Virtual MatrixMonitors
See Control PTZ via our 3D keyboard to use Navigator features.
Now you can select a monitor for Navigator.

+

Press button 1 and MON simultaneously to control #5 Navigator monitor.
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Chapter 12.10 Keyboard Playback
See Control PTZ via our 3D Keyboard to use Navigator features.

To access multi-channel playback, click the Step Forward icon to enter the playback mode.

To access single-channel playback, click the Play icon .

In Playback Timer Setup, use the joystick to enter date and time. Press ENT button to search through videos.
Press ESC to exit and press ESC again to exit the playback dialog box. Below are the control icons to
playback with our 3D keyboard.

Option Icon Description
Pause Pause playback.

Play Start or continue playback video.

Fast Forward Fast forward the playback video.

Fast Rewind Fast rewind the playback video.

Stop Stop playback and return to playback menu.

Select various split display modes on live and playback monitoring.

Chapter 13 eMap Manager
eMap is an application that can manage devices such as IP camera, IP Fast Dome, and DVRs/NVR on any
maps. With eMap, user can easily locate a particular device on a map. Launch eMap Manager in
Navigator→eMap Manager.

Chapter 13.1 Access eMap
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Chapter 13.2 Find Devices
To find a device within eMap Manager, go to View→Find or click the Find Device icon , and a list of found
devices appears at the bottom right corner of the screen. Choose any of the found devices.

Chapter 13.3 PTZ Control Panel
To control PTZ device, double-click a PTZ device, and operate PTZ function on the PTZ control panel.

Chapter 13.4 Toolbar
The icons from left to right are described as follows:

Option Icon Description

Device list Display thedevice list.

Find device Switch to the Find Device panel.

Refresh Refresh the map and device information.

PTZ control Switchto the PTZ control panel.

Edit PTZ control Supports 4 basic presets.

eMap edit mode Add or modify devices on the map.

eMap control mode For PTZ control and live monitoring mode.

eMap alarmswitching mode Switch to the map where an alarm is detected.

Division Switch to quad screen in eMap Manager mode.
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Chapter 13.5 eMap Alarm Options

 Continuous snapshots: the number of continuous snapshots is taken for each alarm.
 Alarm snapshot interval (sec): the time interval between photos to be taken.
 Alarm video output time: triggering interval between alarm detections.
 Number of snapshots stored: the buffer size for storing JPEG snapshots.

Chapter 13.6 Add a Map
To add a new map, go to File-> Add Map. Or you can press the New button at the top-right corner. Select the
JPEG map file representing the installation site and enter map name and location information.

To delete a map, select the map in the Map List, and go to File -> Delete Map or click Delete at the top-right
corner.

Click Property to change the name and location of a map.
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Chapter 13.7 Add a Device to the Map
To add a device to a map, switch to the eMap edit mode before you drag-and-drop a device from Device List
to its associated map. You will see a check next to the name of the added device.

Chapter 13.8 Delete a Device from the Map
To delete a device from the map:

1. Select and right-click the device.
2. Select Delete Device.

Or, uncheck the device in the device list.

Chapter 13.9 Modify a Device
To modify a device, go to Edit→Device Property or right-click a device and choose Device Property. In the
popup dialog box, you are allowed to make changes to several configurations, including display color and
camera coverage.

The circular shape on the right of the Device Properties window allows you to control the direction and angle
of a camera. Click and rotate the camera view control clockwise/counter-clockwise to change the camera
angle and move the two scroll bars at the bottom to adjust camera coverage.

Chapter 13.10 Find a Device
You can easily add DVR, DVR camera, or IP-based devices to different maps. However, finding a particular
device for video playback can be difficult and time consuming. eMap Manager provides easy access to any
device you want to monitor. Click Find Device , or go to View→Find in the menu bar. A list of all devices in
all maps will be shown at the bottom-right corner of eMap Manager. Double-click a device in that list for eMap
to automatically switch to the map and show the device as well as its live video.



57 66-UM-NAV5.0-OE-9

Chapter 13.11 Alarm on eMap
If a motion or digital input alarm sent by Navigator is detected, the camera will start blinking on the associated
map, and the live video will be displayed, too.

Chapter 13.12 Quick Map Reference
In the eMap edit mode, drag any map from the list into the map view. This allows quick switching from one
map to another by clicking on the map thumbnail.

Chapter 13.13 Alarm Control Mode & Switching Mode
In eMap Manager, it is possible to switch quickly and frequently between maps and videos. A user can
manually double-click on the camera icons for its live video. There are up to 4 windows that can be opened at
same time. When switching from one map to another, the video window(s) will be closed, and previously
opened video(s) will be played automatically in the map that just opens The feature is very useful if you need
to open the maps frequently

In the alarm switching mode, videos will appear on the associated map while an alarm is received. The videos
will be shown in a pop-up window to attract your attention.
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Chapter 14 Web Server
Navigator can work as a web server to stream live video. To enable the service, go to System
Settings→Network and enter the HTTP port you want to use.

Then, you may either click JAVA 8080 HTTP web connection mode or copy the link to the address bar of your
Internet browser to view the video.

Note: 1) HTTP streaming may require username and password.
2) Only support IExplore web page.
3) The Win10 8080 Port java webpage has been eliminated, and this function is no longer maintained.
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Chapter 14.1 8021 OCX Web Page Browsing Connection Mode
The OCX web page default is Port 8021, you can also connect and view it through a web browser from other
locations within the local network.

For first-time users, the ActiveX must be installed, simply follow the instructions and proceed with the
installation by clicking on "Next."

Chapter 14.2 Edge Enables IE Compatibility Mode
The OCX component originally only supported IE mode, but now the new Edge browser also enables
compatibility mode. However, you need to access the advanced settings to enable it.If you do not configure
the compatibility mode in advance, then you will only see a black screen without any prompt to install the
ActiveX component.
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Chapter 14.3 NAT Port Setting
When the Navigate LAN server IP wants to share the connection of the external NCC central control network
server, it needs to be forwarded through the NAT port before it can be opened to external connections.

 NAT IP Address: The host IP address
 NAT Command Port: The host shares the HTTP port externally
 NAT Streaming Port: The host shares the monitoring port externally

Chapter 14.4 Apply for a DDNS Account
Click on System Settings->Apply DDNS -> Enter the Account and Password, and then click on Register.
To log in to the DDNS account on the mobile device and connect to NAV, please click on Verify. The cloud will
verify the DDNS registration record of the mobile device, and then you can use the PNS2.0 push notification
function.
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Chapter 14.5 NAV Cloud Push Notification Setting
Alarm Management -> Alarm Output -> Select APP Cloud Push Notification.

Chapter 14.6 Add NAV Device to the Mobile APP
Devices -> Manually Add -> Enter the device account, password, and IP address to connect.
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Chapter 14.7 Enable Alarm and Device Push Notification in the Mobile APP
Settings -> Enable Alarm Events -> Select Device Push Notification (NAV Host)

Chapter 14.8 NAV Confirm Mobile APP Connection
Return to NAV and apply for a DDNS account -> click Refresh -> you will see “mobile verification successful”.
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Chapter 14.9 AI Event Alert Cloud
AI Event Alert Cloud provides AI camera photo push notification and is stored in the Event Alert Cloud. Users
can use it in the cloud or LILIN Pro app. To access the AI Event Alert Cloud, please visit
https://event.ddnsipcam.com

Chapter 14.10 Mobile APP Push Notification for Events
When the NAV channel alarm is triggered, the mobile APP will receive a push notification, and the complete
event list can be seen in the APP Events.

Note: Currently only supports IOS mobile phones push notifications.
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Chapter 15 Database Manager
Database Manager can generate user log report and event report. In addition, this built-in feature allows
database import, export, and repair.

Item Icon Function Description

User Log Report
User account login record, local or remote playback, and device

modification.

Event Report
Device alarm events are triggered, such as electronic fences, cloud

push notifications, and motion detection.

POS Event Report The cash register or backend sends POS text record report.

ANPR Event Report
Allow list, deny list, custom list, country and license plate record

report.

Object Counting Report Camera object counting record report.

Health Record Report Heartbeat and breathing health information.

Access Control Record
Report Door station triggering alarm event record report.

AI Recognition Log
Report AI behavior and object intelligence recognition record report.

TAG Report
Customize a specific recording time, and annotate and mark it (the

marked time period will not undergo recording recycling).

NAV Status
Host health status, including CPU, RAM, NET, DISK, or more

detailed information.

GPS Report GPS satellite positioning record report.

Face Report Allow list, deny list, custom list, and face recognition record report.
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Server Report Local or remote connection events.

Import Database
The system import all parameter settings, such as license plate,

face recognition, e-map, etc.

Export Database
The system export all parameter settings, such as: license plate,

face recognition, e-map, etc...

Export Log Export records reports for various events.

Statistics
Convert alarm records into a line chart for data analysis over

specific time periods.

Refresh Database Refresh the database to retrieve new events.

Search Settings Advanced search settings.

Chapter 15.1 AI Export to IVS Simple Chart
AI recognition database can be easily exported, including object type, object color, countries, automobile
brands, license plate background colors, behaviors, etc., for IVS statistical charts.

Chapter 15.2 System Doctor Advanced Information
Provides more detailed monitoring of host and network usage status and resource usage functions.



66 66-UM-NAV5.0-OE-9

Chapter 16 Multiple Monitors
Multiple monitors support is a native feature in Windows 7 or higher. This feature allows you to view different
applications of Navigator on separate monitors.

Note: 1. NVIDIA standard two graphics cards support up to 4 outputs (Attention! The more channels, the
more CPU resources are consumed)

2. The latest Windows 10 version 21H2 and the new graphics card driver can support up to 6
outputs. For more information, please contact the original manufacturer technical support.

3. When there is an external NVIDIA graphics card and the motherboard has Intel built-in graphics
card, it is recommended not to mix the screen output, and use the external graphics card as the main.

Chapter 16.1 Navigator Multi-Screen Matrix Output
The Navigator can support up to four screen outputs, including one main monitor and three sub-monitors.
Once the display card is properly installed, click on “Multi-monitor output” to display all connected and
detected screens.

Once all the screens are properly connected, please click “Identify Monitor” to display the respective
number on each screen.
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The multi-screen output function is detailed below

 Quad display: Navigator can squeeze four 36 channel views into one large LCD screen
 Default group: the group to be shown on the main monitor.
 Default window division: the default number of split views.
 Auto minimize division: auto minimize division.
 Low CPU usage mode: enable I frame to reduce CPU load
 Alarm Ack Monitor: Customize to display alarm acknowledgment main monitor or sub-monitor.

Chapter 16.2 Alarm Acknowledgement
You can cancel the alarm acknowledgement on any screen that displays an alarm image. Before you manage
the camera, you must first click confirm to clear an alarm.

Note: To enable the acknowledgement function, click Alarm ACK in the alarm output management list.

Chapter 16.3 Notify Navigator on Another Computer
Third-party software can enable or disable videos on the alarm acknowledgement monitor using the CGI
commands provided by Navigator. See HTTPAPI.PDF on our website for more details
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Chapter 16.4 Navigator Software 2x2 Video Wall
Four of the six monitors supported by Navigator can form a 2x2 video wall.

Go to Control Panel→Display→Screen Resolution to combine four 1920*1080 monitors to create a
3840*2160 resolution video wall.

After you finish with the settings, a 2x2 icon will appear at the top-right corner of Navigator, which supports
three windows consisting of thirty-six split views and one eMap view.

Note: The Windows main screen display must be set in the upper right corner to properly display the 2X2
position
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Chapter 17 Retail and Distribution Business Solutions
When connecting to a Point of Sale (POS) terminal ready, Navigator can retrieve POS transaction data, which
will be displayed on live video and video playback. Navigator also provides smart transaction search for
specific video clips.

Chapter 17.1 Retail POS Application
Navigator listens to the ASCII output of a POS system via an RS-232/COM serial port. Check if your POS
LCD or printer is compatible with ASCII or printer output for ASCII data of your POS system. Consult your
POS provider for more details.

Please refer to the figure below to connect RS-232 RX/TX wires, a POS register/terminal, and Navigator host.

To connect more than one POS terminals, add more RS-232/COM ports into the Navigator host.

Chapter 17.2 POS Connection via TCP/IP for Retail Business
Navigator can connect to an RS-232 POS system through the network using a CYT-100SC RS-232 to TCP/IP
converter. The driver disk enclosed in the box of CYT-100SC provides a RS-232 to TCP/IP conversion driver
that allows you to establish a virtual COM port on a Windows-based PC. The virtual COM port can be adopted
by Navigator to communicate with the POS system.

Chapter 17.3 POS system and Navigator Connection Test

After establishing the connection between the POS system and the Navigator host, please use HyperTerminal
or other applications with the same function to test and verify whether the Navigator can capture the POS data

After the connection between the POS system and the Navigator host is established, use HyperTerminal or
other alternative applications to test and verify whether the POS data can be captured by Navigator.
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Chapter 17.4 Link POS to a Camera Channel
To link a POS system to a camera channel, click Properties and choose ePOS/OSD to open the POS
Setting dialog box.

In POS Setting, please specify the following information to capture POS transactions.

 OSD View Setting: the setting can arrange the POS OSD (text) on top of the camera.
 Force Carry Return: For some of the POS printers, these printers might output 80 characters

without carry return. Force Carry Return setting is to force carry return into NAV recorder.

Once the above information is set correctly, Navigator will capture and display POS transactions on live video.
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Chapter 17.4.1 POS Replace Setting
Replace setting is to replace the captured POS text, see picture below:

 String: The setting is to replace the captured “POS#1” wording from the POS machine with “My
Camera”. A user can enter “POS#1” in the “Find what” field and enter “My Camera” into the
“Replace with” field.

 Hex: The setting is to replace the captured POS hex token from the POS machine. For EPSON
printer, the ASCII: LF (oct) and hex (0A) is the carry return for the printer. A user can filter out the
token “0A” in the “Find what” field and enter “”(space) into the “Replace with” field.

Chapter 17.5 POS Transaction Playback
Navigator supports video playback with associated onscreen transaction data. When you choose a POS
transaction entry of any time, the video clip of that transaction will be played from that time.

Chapter 17.6 Search POS Transactions
To search a particular transaction entry such as amount of product, product name, subtotal, or total, you can
enter search keywords in the Condition search box. Transactions containing the keyword will be displayed on
the screen. You can click any of the search items to playback the videos.

Chapter 17.7 Scanner Connection for Logistic Business
Barcode scanners are widely used in logistic business. When connected to a PC via a PS/2 connector, this
device works as an input tool that reads numbers of 0–9 and sends the information to Navigator.

To use a barcode scanner in the transaction process, connect the scanner to the PS/2 port on your PC and
choose Barcode Scanner in POS Setting. Information read by the scanner will be sent to this camera. Only
one barcode scanner can be connected to one PC.

To search for data corresponding to the barcode scanner, refer to POS Transaction Playback and Search
POS Transactions for more details.

Chapter 18 Mobile Device Support
To meet your mobile surveillance requirement, we provide a mobile version of Navigator that
supports iOS and Android devices. You can download IPVideo in App Store or Google Play for
your iPhone, iPad, and other Android devices. (Please refer to the user manual on your mobile
device for more information.)
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Chapter 19 Navigator Software Streaming Client & Server
Navigator’s built-in software server allows video streaming to Navigator clients. Live streaming to clients may
reduce CPU load of the IP camera.

Chapter 19.1 Navigator Streaming Server
To enable the streaming function of Navigator, you may either check Streaming Server in the Network tab in
System Settings and specify the port number therein, or go to Start→All Programs→
Navigator→Streaming Server.

Chapter 19.2 Navigator Software Streaming Client
To connect to a Navigator live streaming server as client, click Properties and select Navigator Live Streaming
from the drop-down list in Device Type. Then, enter the IP address and port number of the Navigator
streaming server.
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Chapter 19.2.1 Navigator Firewall Mode Setting
When the Navigator MStreaming Server opens the port, the user can add or modify the black and white list to
block the connection of the device outside the specified IP or IP location range, which can improve the
server’s security and loading.

Chapter 19.2.2 Navigator Service Settings
By using the tree diagram management, the host can connect to more than 4,000 NAV recording hosts at the
same time, and manage more than 60,000 various connected devices. Through the internal network or
INTERNET connection, real-time monitoring, management, setting and information storage of the remote
NAV recording host can be performed through simple settings. And it can live display and analyze NAV
recording host and equipment real-time image, video data, running status, operation information and various
alarm IO/GPS/POS/license plate information.

Note: Make sure that each NAV host has our Navigator and Control Center installed.

1. In the lower right of the computer toolbar, click on Streaming Server 64 bit and then left click on it.
2. Click on Settings and click on Service Configuration
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3. Check Enable Navigator Control Center
4. Select Server「Control Center Service」.
5. Select Service Type: Navigator Control Center service
6. Create Chinese/English Verification Code and Service Code
7. Click on Setting

"Easy Mode" is checked by default, and the verification code and service code are skipped. Just login the
account and password, to connect to the central control tree diagram device.

 Auto Configure: When the Easy Mode is turned on, directly click "Auto Configure", and it will
automatically be carried into the open server center mode, Control Center TVWall screen mode, and
parallel permission mode

Chapter 19.2.3 Navigator Screen Capture Streaming Setting
Open the screen capture streaming server settings, to provide other servers capture real-time desktop images

 Enable Screen Capture Streaming: Open screenshot streaming server settings.
 Enable Intel GPU encoder: Enable Intel CPU software decoding function.
 Enable Nvidia encoder: Enable Nvidia GPU hardware decoding function.
 Image Quality: The higher the quality, the more refined the picture.
 Max Frames Per Second: Channel picture refresh rate per second.
 Monitors to capture: Select the monitor to capture.
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Chapter 19.2.4 Navigator Setup Receiver
The mobile app Phone Cam supports real-time video uploading to NAV. It can be used to transmit recordings
and store video recording immediately in the event of a fire or traffic incidents.

Its main features include:
 Supports Android, iPhone mobile phones.
 Supports up to four mobile phone connections.
 Fast upload to server for live image refresh.

Chapter 19.2.5 Before Start Using the Navigator Mobile Phone Receiver
Please search, download and install the 「Phone Cam」 app from the mobile app store.

Chapter 19.2.6 Navigator Server Setting

1. Lower right corner of the desktop -> Open Mstreaming Server
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2. Setup -> Set Server -> Select Server01：Public Server -> Check「The device is in use」.

Note: Public Server represents public images.

3. Set NAV channel to NAV JPEG Poster connection mode. (Server001 is the default public images.)
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4. Later, an exclamation point icon will appear in the JPEG Poster mode connection, which means
success.
If you want to replace the idle picture, please go to the directory and replace
C:\navusers\defaultposter.jpg.

5. Run the mobile app "Phone Cam" and click on the center of the screen to capture real-time images
. If the NAV receives the feed successfully, "Connection successful" will be displayed.
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6. NAV will receive the live image feed from the mobile phone and automatically record the video.

7. Return to the server settings, you can see that the Public Server has a group of mobile phones
currently connected. Since it is in public image mode, If too many users' mobile phones are
connected to transmit back to NAV images, confusion may occur.

8. Set NAV channel to NAV JPEG Poster connection mode. (Server002 is private images.)
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9. Return to the server settings, select the connected mobile phone and save the server information.

10. NAV will receive the live image feed from the mobile phone and automatically record the video.

11. The POS database can query historical records.
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Chapter 19.3 How to set Mosaic TV Wall
In second group, please set the service type to Navigator TV Wall service, select Setting and TV Wall set up is
complete.

When host has multiple monitors, one server group can only set one Mosaic TV Wall Server, assuming there
are 2 monitors, server group 3 have to set second group monitor.

Please select Identify Monitor, and the screen will prompt the number for the user to confirm.
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Chapter 19.4 Auto set TV Viewer Setting
Check Auto set TV viewer setting, Mosaic TVWall is automatically evoked when Control Center is turned on.

Note: You may set each TV Wall server group to automatically evoke or not.

Chapter 19.5 Easy Mode
Check Easy mode and apply Auto Check, will automatically skip verification code and service code, this will
enable to import Control Center Service and TV wall mode easily and quickly, click on Setting to complete
easy setting.

Note: When a main host has many monitors, will automatically be carried into all present connected screen
settings.

Chapter 19.6 Easy Mode Advanced Function
 Lazy Sync Target: Easy mode, automatically synchronizes the target.
 Lazy Auto Sync initiator: Easy mode, automatically synchronizes enable.
 Allow automatic provision of services: Allows automatic service activation.
 Allow remote ctrl to reboot NAV/NCC system: Allows remote reboot of the NAV/NCC server.



82 66-UM-NAV5.0-OE-9

Chapter 20 Automatic Number Plate Recognition (ANPR)
Navigator AI Number Plate Recognition (ANPR) can support features including denial list and allowed list for
gate control automation or city surveillance purposes. The purpose of denial list is to prevent unauthorized
vehicles entering an area, thus the system can pop up a window for alarm notification, whereas allowed list
can provide access to the area by opening the gate. Our Navigator ANPR license plate recognition can also
set exclude list to increase the recognition rate.

Features of AI Number Plate Recognition Engine
 Support up to 1080P resolution at 48 FPS.
 Support 2/4/6/8 channels recognition via Navigator.
 Each channel can recognize up to 6 car plates.
 Support group denial list, allowed list and exclusion list setting.
 License plate character size and license plate character length can be set.
 Support real-time and video playback identification display.
 Support for license plate JPEG snapshots.
 Support our IO Box interfacing external devices for gate control.
 Support database synchronization for denial list and allowed list.
 Support up to 200 km recognition speed.
 Support HTTP SDK integration.
 Support Navigator.

Chapter 20.1 Before Using This AI Engine
Please read our IP camera user manual for operating the camera. This user manual only focuses on the AI
Engine feature of the software. AI Engine software is a demo program that allows you to verify recognition
results, after our AI Engine is properly installed.

Chapter 20.2 Caution
Do not use the number plate recognition system with the gate or barrier control for vehicle speed over 10KM/h
or 6MPH due to recognition rate limitation. This will cause a vehicle crash or accident to the gate or barrier
control.

Chapter 20.3 Windows Version 10&11 Cycle Data Table
Different Windows versions may not be able to upgrade the code. It is recommended to download and install
the latest code and Win 10 professional version from the Microsoft website.

System Version Official code Release date
Win10 1909 19H2 2019/11/12
Win10 2004 20H1 2020/05/27
Win10 20H2 20H2 2020/10/20
Win10 21H1 21H1 2021/05/18
Win10 21H2 21H2 2021/10/05
Win10 22H2 22H2 2022/10/18
Win11 21H2 22H2 2022/09/20
Win11 22H2 22H2 2023/01/20
Win11 23H2 23H2 2023/11/11
Format： Old version is not recommended Old version,still supported Standard Version

Standard version The latest preview version
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Chapter 20.4 Windows Version Corresponding Graphics Card Series
It is recommended to use the latest version of Windows code, so no need to worry about matching graphics
card driver version.

Standard Video Card Compatible With Windows Version

NVIDIA Chip

architecture

Windows 10/11 NVIDIA Graphics Card Model No. (Supports super*Ti)

Pascal V. 1607or later
10 Series:GT1030,GTX1050,GTX1060,GTX1070,
GTX1080,TITAN X/XP

Turing V. 1709or later 16 Series:GTX1650&1660

20 Series:RTX2060&2070&2080,Titan RT

Quadro Series:RTX 4000,5000,6000,8000

Tesla Series: Tesla T4

Ampere V. 1803or later 30 Series:RTX3050,3060,3070,3080,3090

Ada Lovelace V. 21H2or later 40 Series:RTX4060,4070,4080,4090

Format： Graphics card is not recommended Minimum specification 2CH

Standard specification 4CH Highest specification 8CH

Chapter 20.5 Install CUDA driver
The current AI version is 11.2. Before using AI Engine, remember to install the CUDA 11.2 installation file first.
It is recommended to update the graphics card driver to the latest version, usually with a backward compatible
version number.

CUDA Toolkit Minimum Required Driver Version for CUDA minor version compatibility*

CUDA 11.7 >=517.40

CUDA 11.2.0 >=461.33

CUDA 10.2.89 >=441.22

Format： CUDA Discontinued version CUDA Old version CUDA Latest version

Chapter 20.6 CUDA Version Compatible with Graphics Card Series
Use the CUDA version with compatible graphics card series, otherwise the AI Engine system will not work
properly.

CUDA Version and Graphics Card Combination
CUDA Version Graphics Card Series NVIDIA Graphics card model (Support super*Ti)
CUDA 10.2 16 Series GTX1650&1660

CUDA 11.7
20 Series RTX2060&2070&2080, Titan RT

Quadro Series RTX 4000,5000,6000,8000
Tesla Series Tesla T4
30 Series RTX 3050,3060,3070,3080,3090
40 Series RTX 4060,4070,4080,4090

Format： Not recommended CUDA10.2 CUDA11.2 CUDA11.7



84 66-UM-NAV5.0-OE-9

Chapter 20.7 OpenVINO™ Compatible with GPU Model Series
If an Intel integrated GPU is used, our ANPR AI series products have a built-in OpenVINO™ driver. After
installing our ANPR AI series, please enable OpenVINO GPU in the system settings.
The CPU i7-level is recommended, must have a GPU internal display to enable the OpenVINO function.

Intel CPU code explanation:
 Suffix letter K: High performance overclocking and support internal display at the same time.
 Suffix letter F: No internal risk.

Note: OpenVINO is no longer supported.

OpenVINO™ and GPU Model Series Combination

Intel Mode Intel GPU

I7-7700/K HD630

I7-8700/K UHD630

I7-9700/K UHD630

I7-10700/K UHD630

I7-11700/K UHD750

I7-12700/K UHD770

Format： Not recommended Supported Recommended Specification Latest Specification

Chapter 20.8 AI Engine Compatible Graphics Card Series
To use the AI Engine version, the compatible graphics card series must be used, otherwise the AI Engine
system will not work properly.

AI Engine Version and Graphics Card Series Combination

Graphics Card Series AI EngineVersion

20 Series AI Engine 1.0.7.152

30 Series AI Engine 1.3.0.152

40 Series AI Engine 1.3.0.152

Format： 20 Series Graphics Card 30 Series Graphics Card 40 Series Graphics Card

Chapter 20.9 AI Engine Back-end License Plate Recognition Settings
The AI Engine channel needs to correspond to the Navigate channel. For example, the 1st channel, click on
the Alarm icon settings -> ANPR Setting -> check the Enable ANPR.
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Chapter 20.10 Navigator Software Setting for AI Number Plate Recognition
Click Navigator software and select camera properties. Click on ANPR Group Setting and make sure
that the communication of AI Number Plate Recognition is at 8592 port.

 Enable service: Enable AI Engine & AI function.
 Enable watch dog service: Automatically watch dog detection mode.

Please click the camera settings button or the right mouse button on the channel to enter the properties page.
Please check “ANPR Detection” option in the "Alarm Input Management" item of the alarm management page.
After checking this item, click "Options" to enter the settings.

 Camera Properties->Alarm Management->Click on ANPR Detection

Note: When using Navigator VMS and AI Engine, there is no need for opening AIEngine.exe for saving CPU
usage.
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Chapter 20.11 License Plate Character Height Adjustment
The maximum and minimum length of characters to identify the license plate can be defined according to the
requirements of license plates in different countries, which can shorten the time of the license plate search
engine.

Chapter 20.12 ANPR System List Setting
Each group of license plates can be set as a group, for example, preset groups such as "white list", "denial
list" or "exclusion list". It is also possible to add a group and specify its function application group, and set the
corresponding output after the license plate is detected.

To set license plate group, click "License Plate Group Setting". After entering the license plate database,
create a group from the list according to the ownership of the license plate, trigger the alarm with this group,
and other settings:

Chapter 20.13 License Plate Import/Export List
Support import/export list report. The function displays license plate and vehicle information in the Excel CSV
file format.
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Chapter 20.14 The Settings of AI Traffic Management
Click on Enable traffic detection for using AI traffic objects detections. For traffic behaviors, the behavior is
defined in a traffic detection zone. There are four detection zones programmable for traffic objects. Follow the
instructions below for setup.

Note: It is important to disable “Enable traffic detection”, if traffic detection is not used to save CPU or VPU
usage.

Chapter 20.15 Traffic Zones
Click on buttons for inserting or deleting a traffic detection zone. Once a detection zone gets added,
drag the Anchor of the zone to fit the environment. There are up to 4 traffic zones for detecting the behaviors
of traffic objects.
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Chapter 20.16 Prohibit Zone Detection (Parking Violation)
To set up an alarm notification for an object entered the prohibited detection zone, please select the “channel”
number for setting and key in the object names in “metadata”. Add a detection zone to desired area. Tick on
“Prohibit zone detection”. Click “Apply” to save the settings.

It can be used in applications such as prohibited areas for vehicles, i.e. large trucks entering the urban district.

1. Add or delete detection area
2. Select behavior detection
3. Parking violation identification status
4. Enable the metadata, car, truck, SUV, etc for detection
5. Set the dwell time to detect the violation time

Chapter 20.17 Queuing Detection
To set up an alarm notification for the number of objects entered the detection zone reached the maximum
occupancy, please select the “channel” number for setting and select the object names in “metadata”. Add a
detection zone to desired area. Tick on “Queuing detection” and key in the number of objects in “Count”.
Click “Apply” to save the settings.
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 Enable traffic detection: Enable AI traffic engine. Disable other AI engines for saving GPU load.
 Detection zone: Insert a zone for traffic behavior.
 Enable direction: Enable direction if traffic flows are needed such as turn left, turn right, and wrong way

detections.
 Metadata: Select the object names for filtering the objects having a desired traffic behavior.
 Counter: A global counter for behavior event.
 Dwell: The time for parking violation.
 Count: The count of objects in a sense used by queuing detection.

Chapter 20.18 Human Mask Detection Setting
To set up the mask detection and no mask detection of an object entered the detection zone, follow the
instruction below:

1. Click on “Enable Human detection”. Please select the “channel” number for setting and specify “face,
half_mask, mask” in “metadata”. Add a detection zone to desired area. Select “Mask detection” and/or “No
mask detection” behavior. Click “Apply” to save the settings.
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2. Configure the HTTP post by clicking on event icon. Then, click on “Enable HTTP notification”. Click on
“Add” or select an event to “Edit” in “Notification events”. Then, type in URL field
/cmd=naveventmsg?cmxcgido=1&audiono=1&interval=0. Click “OK” to save the settings. This is to notify the
Navigator for playing an audio.

Note: “Navigator HTTP meta output” is an event name used as an example to show how to configure HTTP
post. User may create a name for an event.

3. Enable the HTTP Post Notification to No Mask Detection. To enable, click on “No mask detection”. Press
“Set Output” and tick on “Navigator HTTP meta output”. Click “OK” and “Apply” to save the settings.
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Chapter 20.19 Social Distancing
To set up social distancing, a rectangle area can be mapped to our AI software for calculating social distance.
To do so, follow the setup steps below:

Chapter 20.20 Setup Social Distancing
To set up social distancing, enable “Social distance” feature. Select Social distancing behavior. Click on

button for setting social distancing. The social distancing feature works only in the rectangle area.
The settings are described below:

 Unit: The rectangle area’s unit, meter or feet
 Width of detection zone: The X axis, width, of the rectangle area
 Depth of detection zone: The Y axis, height, of the rectangle area
 Display distance: If two people are in the social distance, show the detection lines.
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Once the social distance area gets set up, set the metadata to person. (Please select “Person” in the
Metadata of the Traffic Management settings first. Then, select “Person” in Metadata of Human Detection
settings.)

Note: There is only one detection zone that can support for social distancing feature.

The detection must be a rectangle area. Setup social distancing counter to, for example, 5 people
distance. This can detect the social distance of these 5 people that are too close. You can also enable the
display counter for verifying purpose. This can show how many times the area having violations of
social distance.

Chapter 20.21 People Density of AI Software
To count the density of people in an area, follow the steps below:

1. Create a detection zone.
2. Enable people density.
3. Set metadata to “people”.
4. Add the people density count.

Once the people detected in the area is greater than density count, you can program HTTP post or event
counter for outputs.
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Chapter 20.22 Setting the Front-end Camera AI Function in Navigator
Launch the Navigator main program, click on "Camera Settings" button, "Alarm Management" -> check

on "AI Behavior Detection" ->click on “Options” -> AI Server/IP Cam, click on "Auto detect AI IP Camera", tick
on "Get detections from AI server / camera directly.

Chapter 20.23 AI Alarm and Behavior Detection Setting
With the Edge front-end camera authorization, check the AI Alarm AI Type and AI behaviors in Navigator.
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 Recognition: The channel recognizes the highest number of frames.
 Speed: The CPU accelerates, up to 4x maximum.
 Display detection zones of AI: Enable or disable the AI detection zone display.
 Display detected object bonding boxes: Enable or disable the real-time object tracking box display.
 Display tracking ID: Enable or disable tracking ID display (the object tracking box must be enabled

first).
 Enable AI type: Whether to display AI type detection (for example: vehicle detection).
 Filter out the objects without behavior: If there is no triggered behavior detection, the filter will not be

displayed, reducing the screen complexity.
 Filter out the objects without speed: If there is no triggered speed detection, the filter will not be

displayed, reducing the screen complexity.
 Object + behavior and trigger alarm: When AI detection and behavior detection are triggered

simultaneously, the alarm will be triggered.

Chapter 20.24 Setting of Front-end Camera Counter on the Webpage
Enter the Edge camera webpage -> select "AI Recognition" -> check the object classification and
behavior detection, -> select "Counter01"as the counter -> customize the calculation unit, and once the
setting is complete, the value of the counter01 in the lower right corner will change.

Chapter 20.25 Setting to Synchronize Front-end Camera Counter in the Navigate
When the counter is enabled on the webpage, NAV can synchronize the camera counter. Click on “Alarm
Management” ->check “AI Behavior Detection” -> “Options” -> “NCC Counter” -> “Use AI Counter” ->select
the corresponding counter “CNT 01”.
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Chapter 21 Face Recognition (Premium Authorization)
The face recognition welcome system is a face recognition system on the NAV software platform. It compares
the entered face database, and the faces can be classified according to the white list (VIP list), black list and
visitor list, and trigger related alarms output.

Our world-class facial recognition accuracy, flexibility, and ease-of-use make Navigator software right choice
for retail, access control, time and attendance, surveillance, denial list/VIP greeting management, and other
applications.

Chapter 21.1 System Configuration
After a camera is configured, follow the steps below:

 Select Alarm Management
 Select facial recognition option from alarm input management
 Select alarm output, e.g., triggering DO of an IP camera.
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Chapter 21.2 Configure Detection Area & Facial Recognition
According to the installation site, you are able to define the recognition area. For defining the detection area,
follow the steps below:

 Click Facial Recognition option.
 Click Options button.
 Use a mouse dragging on the video area for detecting area.
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Other settings are described below:

 Image detection area: Support full image detection
 Minimum facial recognition confidence rate (%): When the confidence rate is achieved, will indicate

successful recognition and trigger an alarm.
 Same face repeated recognition times: To achieve recognition accuracy, the number of times the

same face is recognized for a successful facial recognition.
 Same face recognition interval: Total number of recognition interval of the same face.
 Speed: 1x speed represents 1 CPU thread. The faster the speed, the higher the CPU usage.
 Minimum face pixels to reduce guests (width, height): When lower than minimum face resolution,

the face will not be recognized.
 Enable face searching mode: Support facial recognition tracking.
 Face Resolution in Pixel (H and W): The pixel size of the photo after face recognition
 Show Guest：Display guest function

Note: Reduce guest is to adjust level required to increase the face recognition match to data base.

Chapter 21.3 Facial Recognition and Alarm Output
After face photos are added into facial recognition database, the face photos can be grouped into different
lists. Based on the groups, you are able to trigger an alarm output for a grouped list. To set, select as per
your requirement from Alarm Output -> Alarm Input Management -> Option -> Define motion area (optional) ->
Approved Group -> Approved Group Name > OK
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Chapter 21.4 Set Alarm Output Settings for Applications
The alarm outputs for a detected face can be triggered for many applications.

 VIP greeting: Enable Alarm Full Screen with OSD display for the VIP guest.
 Access control: Enable Signal Digital Output can trigger DO of an IP camera for opening a door.

Chapter 21.5 Schedule of Facial Recognition Triggering a Digital Output
For access control application, IP camera relay output can connect to an access control for opening a gate or
a door. You can also apply the schedule for weekdays for automation. To set, select as per your requirement
from Alarm Output -> Alarm Input Management -> Enable Alarm Notification Schedule Day/Time -> OK
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Chapter 21.6 Add Faces Photo into Database
In camera property dialogue box, click Face Snapshot button. The snapshot of the Facial Recognition
dialogue box shows up for adding a face photo and entering personal information.

Chapter 21.7 Add Photos Database for a Face
For adding face photos, follow the steps below:

 Enter the name.
 Click on “…” button for adding Group button.
 Select the group name.
 Click on the name list for deleting or modifying the person’s information.
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Note: Manual Recognize is to know the level of recognition.

Chapter 21.8 Adding Photos into Database
For adding a photo into the facial recognition database, you can click on Snapshot or click on Image File
button. After a photo is loaded, you can click on Add button for adding into the facial recognition data base.

Note: The face of the photo needs to meet minimum pixel requirement.
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Chapter 21.9 Historical Recognized Data
The face photo recognized will be saved in the History Event list. Click on the name, the recognized photo
can be displayed in the temporary area. Click Add button to add the photo to the database. If a face is not
recognized, the face is added into guest list. You can add the photo into a database for elevating the
recognition rate.

Note: It is highly recommended to have photos in different angles of a person.

Chapter 21.10 Historical Guest Face Tracking Search Mode
You can customize the search by date and time, search for guest recognition in the History Event list, and edit
the guest as black list or white lists, and etc.

The faces can also be searched through picture, will compare with the face database to recognize the similar
picture, and edit the verified identity of strangers in the list.

Note: The face pixel size and confidence degree of the search conditions will increase or decrease the search
time.
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Chapter 21.11 Search the Name for the Video
Click on playback button and select Facial Recognition option. You are able to search the entire name list

of recognition.

Chapter 21.12 Playback
Click on the names after recognition for video playback.
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Chapter 21.13 Advance Facial Recognition Setting
Enable the face API command, go to “Advance” -> check the “Enable web API checking service”, and then
you can transmit the command to the facial recognition host through the remote transmission.

Chapter 21.14 Installations
For better recognition rate, follow the guidance for installation cameras.

 The environment of facial recognition cameras needs be at least 450Lux.
 The shutter speed of the camera should be 1/60 sec or 1/50 sec.
 Leveled camera installation facing a face at distance 3-5 meters.
 The pixel size of the photo should be 100 x 100 or higher.
 Do not use 4K cameras to slow down the recognition speed.

The following pictures are not good for facial recognition.

Angle of the face Wearing a helmet Mask blocking Glasses too dark

Facial recognition requirement

 Face photo pixel requirement: 70 x 70 pixel or higher
 Detectable face angle: Up and down +/-15 degree, left and right +/-15 degree
 Environment minimum Lux: 450Lux～1,000Lux
 Face detection condition: Eyes, eyebrows, and nose can not be blocked.
 Recognition time: 1 second at 2000 photo db.
 Recognition distance: 0.5M～6M
 Shutter speed of the camera: 1/50 or 1/60 sec or higher
 Facial makeup might affect recognition rate.



104 66-UM-NAV5.0-OE-9

 Avoid strong back light environment
 Increase camera brightness if the skin of a face is too dark or the camera faces strong back light.
 Do not use 2.2 mm and 2.8 mm lens due to distorted faces.

Note: Do not use camera IR mode. Black and white video from camera does not work with facial recognition
system.

Chapter 21.15 Confidence Rate and Pixel of a Photo
In general, the confidence rate of facial recognition might be affected by the pixel size of a photo. The
following table describes examples of confidence rate and pixel size of a photo. However, the confidence
rate could be also affected by poor lighting and bad video quality.

Photo resolution 128 x 114 320 x 310 430 x 430
Confidence 67% 86% 95%
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Chapter 21.16 Two Phases of Quick Face Photos Setup
For quick face database creation purpose, use Import feature for importing a batch of photos into face
database after finishing cameras and NAV setup.

The face database has at least one face photo for a person. Utilizing the facial recognition feature, the
camera keeps capture face photos for NAV to recognize. In History Event dialogue box, click Add button for
adding the recognized photos for a person. For increasing the recognition rate, at least 5 photos of different
angle of a person are highly recommended.

Chapter 21.17 Camera Setting Requirements:
Camera settings for facial recognition are described as below:

1. Shutter speed: To increase recognition rate, set the shutter speed of camera to 1/60 or 1/50 for
avoiding video motion blur.

2. AGC: Increase AGC setting for increasing the luminance of the camera.
3. 3D noise reduction: Disable 3D noise reduction to avoid video motion blur.
4. Exposure value: Adjust exposure value for increasing the luminance of the camera.
5. Noise: If the noise of the camera is too high, try lower the sharpness for reducing noise.
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Chapter 21.18 Face Recognition Datasheet
Items Specification

Recognition speed 10-11 recognitions per second for a camera
Number of channels 4 cameras up to 40 recognitions / sec
Number of faces Up to 4 faces per picture

Minimum face photo pixel
requirement

80x80 pixel: 70% confidence rate,
300x300: 80% confidence rate,
450x450 pixel: 90% confidence rate

Detection distance 0.5 ~ 6m, face photo with 80x80 ~ 450x450 pixel

Video resolution supported 720P 30FPS，1080P 30/60FPS
Maximum people detection
allowed 10,000 people, 100 000 photos database

Face training database 10 pictures for a person updatable from the guest list

Recognition rate Up to 99.82% recognition rate (based on LFW International Facial Recognition
Database, database 5000 people, 14000 pictures)

Recognition time 1 second at 2000 photo database

Detectable face angle Up and down +/-15 degree, left and right +/-15 degree

Environment minimum Lux 450Lux～1000Lux

Face photo database Batch photos import
Face detected for alarm
triggering Full screen, OSD text, digital output triggering, buzzer, PTZ preset

Face lists VIP list, unauthorized list, guest list

Guest list Guest list allows added into face database (training)

Schedule 4 scheduling tables for alarm outputs and DO triggering

Visitor List Recognition
Training

The visitor list can be added to the database to increase the recognition rate

Camera supported ONVIF IP camera and RTSP stream

Video recording 4-ch Navigator 5.0 Corporate license

CPU I7-10700 or higher (8C/16T)

RAM 32GB DDR4-2400

Graphics RTX 2060Superor higher

OS Windows 10 Professional Edition (Version 21H2) and higher

SSD 500GB

HDDs Up to 3 HDDs for recording

Applications Access control, time and attendance, surveillance, denial list/VIP greeting
management
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Chapter 22 Failover
The Navigator recording server can be configured for failover mode. If one or more Navigator recording
servers lose the network connection for cameras or need to be switched off for maintenance purpose, the
Navigator recording server (failover server) with failover enabled can record videos for these cameras of
Navigator recording servers.

Chapter 22.1 Channel Hot Spare Mode
One failover server can connect to 8 Navigator recording servers for failing over the task.

One Navigator failover server can rescue 36 channels of a Navigator recording server. This Navigator
recording server cannot accept second failover server, so you have to decide which cameras are very critical
for failover feature.

Failover server number of channels cannot exceed its specification where NAV 24 Bay host at failover mode
can rescue 108 cameras.

Example:
One 108ch at failover mode can only rescue 3 units NAV video host camera recorders, each NAV video host
user chooses 36 channels to rescue.
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Or one 108CH licensed service host can rescue 8 clients average 13 channels per server. (According to the
number of server host licenses 13 x 8=104)

Chapter 22.2 Host Hot Spare Mode
One fault-tolerant migration service host can back up for up to 60 Navigator recording service hosts, and
perform fault-tolerant migration video recording services.
When a client disconnects, the channel settings are backed up to the fault-tolerant host. However, only one
remote NAV service can be backed up at a time.

Chapter 22.3 Enable Failover Monitoring Service
To enable failover on the failure over machine, please click System Settings and go to the Failover tab.
Select Failover server mode if you want the Navigator recorder to operate as a failover server; select Failover
client mode if you want your workstation to operate as a client.

For failover server, choose one of the clients (Navigator recorders) from the list, and specify the host IP
address, port number, username, and password to enable the monitoring service. The default port for
Navigator is 8021. To enable failure alarm, please select Auto Alarm Loop.
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Chapter 22.4 Failover Client Setting
For the Navigator recording server that will be rescued, choose Failover Client mode. Press OKbutton and
re-launch Navigator application.

Chapter 22.4.1 Channel Hot Spare Mode
For the failover client (backup host), please check “Failover enabled” in the properties of the camera to be
used as the failover client, as shown in the figure below:
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Chapter 22.5 Fault -Tolerant Migration Service Host Setting
For the failover server, please fill in failover client 01, the IP info of the server, which will be rescued, press ok
to validate and you will be asked to re-launch the Navigator application

Do the same for the cameras you want to rescue.

Note: The failover server cannot be used for normal recording, if you had a previous setting on this server,
they will be inactive.

In the group page you will see 8 new groups.
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After re-launching Navigator, go back to failover setting you will see on the right all cameras selected for
failover server.

Press inquiry

To test this function, for example, the Navigator recorders (failover clients) suddenly power down at 13:57:00,
failover server will start recording selected channel until failover clients are recovered.



112 66-UM-NAV5.0-OE-9

Go to failover server playback interface, you will see a new group

You can now playback data on the server.

Note: That data on failover server want not be copied to the original failover client, so you need to know at
what time the issue happens to check the correct server to find the data.

If you need the failover client has the missing data, you need to use the archive manager function, but it will
be very slow and it will backup one channel at a time and also bandwidth consuming.

Chapter 23 Utility Tool
When users need to make extensive batch modifications to application functions without opening the software,
they can make adjustments using a utility tool, saving a lot of tedious time.
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Chapter 23.1 SyncSetInfoTool
This function is about NAV camera property page adjustment.

1. Directory: C:\navusers\APP Schedule
2. Execute SyncSetInfoTool.exe

Sync function:
 Connect Mode: Supports main/sub stream output of images with two different bit rates.
 Record Mode: Supports main/sub stream recording or dual stream recording, and supports

low-capacity recording mode.
 Time Adjust: Synchronize with the local PC time.
 Low Bitrate CMX HTTP Server Mode: When checked, saves bandwidth in the HTTP Port external

web connection channel Live screen.
 HTTP, HTTPS, Onvif, Video Port: The device’s connection port.
 Protocol: Streaming protocols, RTP/UDP, RTP/TCP, or RTP/TCP/HTTP.
 Select Channel: You can independently select channels for the above functions or choose to apply

to all channels.
 All open: All channels are enabled.
 All close: All channels are disabled.
 Arrange normally: Restore the default channel sequence.
 Apply: Applies the settings.

Chapter 23.2 SetNavAndNccOpenAPPEX
This function is about the automatic login and software startup waiting time of NAV, NCC & AIEngine.
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 NAV Set OPEN: After NAV is started, the waiting time before software login.
 NCC Set OPEN: After NCC is started, the waiting time before software login.
 AIEngine Set OPEN: After AIEngine is started, the waiting time before software login.
 ClearRegistrationInfo: Clear NAV registration license. (Please use with caution!)。
 ClearFilesAndAutoOpenApps: Clear all settings and databases for NAV, NCC, and Client. (Please

use with caution!)

Startup sequence time specification:
1. NAV > NCC
2. AIEngine = NAV or AIEngine < NAV

Chapter 24 Troubleshooting and Support

Chapter 24.1 Choosing between SMR and CMR in Hard Drives
Many people ask what is the right hard drive for the intended use. Because different recording methods have
different performance, SMR is used for cold data storage and CMR is used for repeated reading and writing
data. Both technologies have their own characteristics for reasonable and right application.

In our guide, it is usually recommended to use CMR hard disks. When the recording host often reads and
writes or important data transmission is important, CMR hard disks are a good choice. It is recommended to
choose the Pro series of the same model, which can read and write for a long time. To maintain life and
warranty, the following are WD and Seagate series hard drives.

For more detailed hard drive model brands, please consult the original manufacturer's technology.

Brand Model # Format Application RAID 5
WD Purple Surveillance AI CMR DVR&NVR monitoring power saving or small video

recording
8 Bay

WD Red Pro NAS CMR NAS RAID small and midsize video recording 16 Bay
WD Ultrastar DC HC530 CMR NAS or medium-scale video recording database 16 Bay
WD Ultrastar DC HC550 CMR Database and recording a connected large number of

channels
24 Bay

WD Ultrastar DC HC570 CMR The database is frequently written and read, and JBOD
has more channel recordings.

24 Bay

WD Gold Enterprise CMR The database is frequently written and read, and JBOD
has more channel recordings.

24 Bay
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Note: Technically speaking, SMR also uses a vertical magnetization method, so in order to segregate, the
original PMR is renamed CMR.

Note: Depending on the grade or type of the hard disk, the hard disk will decline for a certain period of time
when reading and writing, and then return to the normal writing speed. It is generally recommended to use the
enterprise-level hard disk of the database to process a large amount of images or retrieving data. In addition,
please ensure to keep more than 10% of the reserved space, which aids in buffering hard disk writing.

Chapter 24.2 Computer Room Guidelines
Generally, the computer room should maintain a temperature of 24 ± 4℃ and a humidity level of 50 ± 20%.
Too high temperature and humidity can lead to component corrosion, shortened lifespan and equipment
failure. Clean regularly to reduce dust accumulation and reduce the risk of overheating. Please ensure that
these assets are protected from any moisture-related environment.

Chapter 24.3 5.0 System Requirement
The requirements for NAV recorder host and AI recognition server are as follows.
* The number of channels depends on the CPU cache speed. (Simulated scenario calculation: Multiple split
screen 480P 15FPS)
Video decoding for the recording host: H.264/265 CPU type.

Brand Model # Format Application RAID 5
Seagate SkyHawk AI CMR DVR&NVR monitoring power saving or small video

recording
8 Bay

Seagate lronWolf Pro NAS CMR NAS RAID small and midsize video recording 16 Bay
Seagate Enteprise Exos 7E8 CMR Database and recording a connected large number of

channels
24 Bay

Seagate Enteprise Exos X16 CMR The database is frequently written and read, and JBOD
has more channel recordings.

24 Bay

5.0 NAV Recorder System

Minimum System Requirements Basic System
Requirements

Recommended System
Requirements

Operating System Win10 Pro 22h2(64 Bit) Win10 Pro 22h2(64 Bit) Win11 Pro 22h2(64 Bit)

Processor Frequency 2.4Ghz or higher 2.6Ghz or higher 3.0Ghz or higher

Core Processor 6C/8T or higher 8C/16T or higher 8C/16T or higher

Processor Intel® Core 10th i5 or higher Intel® Core 10th i7 or higher Intel® Core 12th i7 or higher

Recording Channel 36-ch 72-ch 108-ch

Dynamic Recording
Channel

16-ch 36-ch 72-ch

Number of AI camera
supported

16-ch 36-ch 72-ch

Number of AI
Recognition Channel
supported

4-ch 8-ch 16-ch
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Hard disk Quantity 8 BAY 16 BAY 24 BAY

Built in Graphics Card Intel® HD Graphics 630 Intel® HD Graphics 730 Intel® UHD Graphics 730

Dedicated Graphics
Card

Nvidia GT1030 Nvidia GT1050 or higher Nvidia GT1050 or higher

AI Video Memory 16GB or higher 32GB or higher 64GB or higher

Video Memory 16GB or higher 16GB or higher 32GB or higher

Dynamic Video Memory 16GB or higher 32GB or higher 64GB or higher

System Disk Space System SSD 256GB or higher System SSD 256GB or higher System SSD 500GB or higher

Database Event
Storage

1TB or higher 1TB or higher 1TB or higher

Storage Disk Level NAS PRO or higher
NAS PRO/Data Enterprise or
higher

Data Enterprise or higher

RAID Level RAID 5 RAID 5, 50 RAID 5, 50

RAID Model 9361-8I 1G or higher 9361-8I 1G or higher 9362-8I 2G or higher

RAID CARD 6 Gb/s or higher 12 Gb/s 12 Gb/s

Internet Connection 1000Mbps RJ45 or higher 1000Mbps RJ45 or higher 1000/10000Mbps RJ45 or higher

Monitor Resolution
1280 X 1024 Minimum
Resolution

1920 X 1080 Recommended
Resolution

1920 X 1080 or higher

5.0 AI Recognition System

Minimum System Requirements Basic System
Requirements

Recommended System
Requirements

Operating System Win10 Pro 22h2(64 Bit) Win10 Pro 22h2(64 Bit) Win11 Pro 22h2(64 Bit)

Processor Frequency 2.4Ghz or higher 2.6Ghz or higher 3.0Ghz or higher

Core Processor 6C/8T or higher 8C/16T or higher 8C/16T or higher

Processor Intel® Core 10th i7 or higher Intel® Core 10th i9 or higher Intel® Core 12th i7 or higher

Recording Channel 4-ch 9-ch 16-ch

Number of AI
Recognition Channel
supported

4-ch 8-ch 16-ch

Database Event
Storage

1TB or higher 1TB or higher 1TB or higher

Built in Graphics Card Intel® HD Graphics 630 Intel® HD Graphics 730 Intel® UHD Graphics 730

Dedicated Graphics
Card

Nvidia RTX3060 or higher Nvidia RTX3060 or higher Nvidia RTX3080 or higher

AI Video Memory 16GB or higher 32GB or higher 64GB or higher

Dynamic Video
Memory

- - -

System Disk Space System SSD 256GB or higher System SSD 256GB or higher System SSD 500GB or higher

Storage Disk Level NAS PRO or higher
NAS PRO/Data Enterprise or
higher

Data Enterprise or higher

Internet Connection 1000Mbps RJ45 or higher 1000Mbps RJ45 or higher 1000/10000Mbps RJ45 or higher

Minimum resolution
for object
recognition

Up to 120 X 120 Up to 120 X 120 Up to 120 X 120

Monitor Resolution
1280 X 1024 Minimum
Resolution

1920 X 1080 Recommended
Resolution

1920 X 1080 or higher
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Note:
1. GPU decoder does not support AMD display cards
2. Windows 2012 R2 operating system is not recommended
3. Video recording HDD compatibility table, please contact the original manufacturer technical support.

Chapter 24.4 Other Peripheral Hardware Support Table

5.0 Facial Recognition System
4 Monitors System Requirement 6 Monitors System Requirement
Operating System Win11 Pro 22h2(64 Bit) Win11 Pro 22h2(64 Bit)

Processor Frequency 2.4Ghz or higher 2.6Ghz or higher

Core Processor 6C/8T or higher 8C/16T or higher

Processor Intel® Core 10h i7 or higher Intel® Core 12th i5 or higher

Face Recognition camera number
supported

2ch 4ch

Dedicated Graphics Card Nvidia RTX2060 or higher Nvidia RTX3060 or higher

Memory 32GB or higher 32GB or higher

System Disk Space SSD 256GB or higher SSD 256GB or higher

Storage Disk Level 1TB or higher 1TB or higher

Internet Connection 1Gbps RJ45 or higher 1Gbps RJ45 or higher

Face Recognition supported
channels

Up to 2ch Up to 4ch

Minimum resolution for object
recognition

Up to 80x80 pixels Up to 80x80 pixels

Camera resolution 1080P between 30 and 60 frames 1080P between 30 and 60 frames

Monitor Resolution 1280 X 1024 minimum resolution 1920 X 1080 recommended resolution

Hardware Support List

Supported Device Supported Model

Our 3D Keyboard Use USB convert to RS-232/RS-485, PMH-RS485/USB USB to RS-232/485

RS-232 to TCP/IP network supports our 3D Keyboard or RS-232 POS.

CYT-100SC RS485/RS232 to TCP/IP ConverterRS-232 POS System

Ethernet Cash Register Drawer APG-480/APG-490

MOXA Remote I/O Control Box ioLogik E1210, E1211, E1212, E1214

Embedded Video Decoder Our Video Decoder

Barcode Scanner LS1203

USB Fingerprint Lock USB FINGERPRINT LOCK

USB Microphone DIKE DVM600

PCIe Network Card 2.5G STL N-690(Intel 1225-V)
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Chapter 24.5 Automatically Login In Windows 10& 11
This method applies to Windows 10 account. You do not need to enter your account password each time you
turn on your PC. Windows 10 will automatically boot to the desktop.

Please be aware that enabling automatic login makes your computer more convenient to use but anyone can
simply turn on the computer and access your personal data, so it’s less secure than logging on manually. That
needs to be taken into account.

In addition, if it is "System logout" or "Account Lock", you have to enter the password to log in again. Which
means this method is suitable for operating system booting only. And it is possible that entering a password is
required in other operations.

The areas with unstable power, or Windows updates in the middle of the night, may reboot the system. In
order to quickly restore system operation and maintain the LAN connection security, you can apply the
following methods.

Note: Navigator 3.0 does not support switching between multiple Windows accounts. Please upgrade to
version 5.0.

1. Windows 10 User Account Settings
1. Type netplwiz into the Search bar and enter the username account.
2. After open User Accounts, you will see Users must enter a user name and password to use this

computer option ischecked by default. This means a username and password must be entered to
log in.

3. If " Users must enter a user name and password to use this computer" is not available, the
reason is that Windows 1803 is a newer version and Microsoft hides this option. To enable this
function, please refer to the following:

PCIe Network Card 10G STL N-760(Aquantia AQC113CS)

Screen Adapter Cable DP TO HDMI 4K UGREEN /DisplayPort to HDM

Screen EDID Emulator 4K BENEVO Screen EDID Emulator (BVDHDMI4K)

Display Graphics Accelerator

GT 1030
GTX1050/1060
RTX 2060/2080/3050/3060/3070/3080/3090
RTX 4060/4080
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 Type regedit in the search bar and enter the Register Editor.

 Navigate to the following path
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsNT\CurrentVersion\PasswordLess\
Device and change the DevicePasswordLessBuildVersion decimal value to 0.

Note: If there is no DevicePasswordLessBuildVersion option, please create DWROD.
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 Run "netplwiz" again and Users must enter a user name and password to use this computer
option will show up.

2. Disable and Change User Accounts and Password Settings
For user accounts, please click the Advanced tab.Then, click Advanced on Advanced User Management.

Note 1: NAV host default user account: NAV; password: blank.
Note 2: NAV host has the highest authority by default.

 Click Advanced.
 Click Advanced user management, and click on Advanced.
 Enter Local Users and Groups. Then click on Users on the console tree.
 Enter the redundant user account and check Account is disabled.
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Note 1: Attention!Windows requires at least one set of user account to log in. Disable all accounts will cause
Windows login failure.

Note 2: For non-original NAV host users, it is recommended to keep at least one set of user accounts with the
highest system administrator authority, and close the other user accounts.

3. User Account Control Settings as Administrator
When only software license or a non-original NAV host is purchased, the user account does not necessarily
have the highest privilege. Hence, have to configure the user rights through the following settings:

 Click User Accounts, and click on the Users must enter a user name and password to use this
computer check box.

 Click Properties.
 Click Group Membership.
 Select Administrator.
 Click Apply to save the settings.
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4. Change User Account Name
When renaming the user account name arises, it can be modified as follows:

 Click User Accounts, and click on the Users must enter a user name and password to use this
computer check box.

 Click Properties.
 Under General, modify the user name.
 Click Apply to save the settings.

Note: After modifying the user name, make sure to restart the computer. Otherwise, the account cannot be
passed to execute some programs (For example: MegaRAID login)

5. Store Username and Password in Computer Settings

 In the User Accounts dialog, select your user account first and then uncheck Users must enter a
user name and password to use this computer. Click the Apply button and automatically sign in box
pops up.

 Type your password, and then re-enter the password to confirm the same.
 Click OK to save the settings.

The next time the computer restarts, it will remember this set of passwords and automatically log in to the
desktop.

Note: After modifying the user password, make sure to restart the computer. Otherwise, the account cannot
be passed to execute some programs (For example: MegaRAID login).
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Chapter 25 System Optimization
Chapter 25.1 Windows Change User Account Control Settings
Before installing Navigator on Windows 7 and Windows 10, go to Control Panel → System Security → User
Accounts → Change User Account Control Settings and lower the setting to "Never Notify." This will confirm
that when the watchdog timer reboots the system, Navigator will automatically open and log in.

Win7 Example:

Win10 Example:

Note: User Account Control (UAC) is a feature in the Windows 7&10 operating system. When user account
control is turned on, the application will always run with the security content of a non-administrator account,
unless the system administrator specifically grants system access rights at the system administrator level.
Otherwise, UAC will prevent the automatic installation of unauthorized applications. To turn off this feature,
please set it as follows.
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Chapter 25.2 Turn off Hard Drive Defragment
In Windows OS, please go to Control Panel->System and Security->Defragment your Hard Drive->Configure
Schedule->Uncheck “Run on a schedule (Recommended)”.

In Windows 10 OS, please go to Control Panel-> Security and Setting-> Defragment and optimize your drives,
click on Change Setting and uncheck “Run on a schedule (Recommended)”.

Note: SSD (Solid State Disk) principle is different than traditional HDD. SSD does not have magnetic head
and disk does not have physical moving parts latency, when a command gets issued to access a magnetic
zone, the circuit can be transmitted as soon as the circuit is turned on. The time required to read any magnetic
zone is the same or much faster than traditional HDD, but traditional HDD can configure RAID5/50, there is no
need to disk defragment to speed up. Therefore, it is recommended to turn off Hard Hard Drive Defragment to
reduce system’s loading.
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Chapter 25.3 Turn off creating file content index
The indexing is mainly to establish contents of all computer files into searchable keywords, so as to quickly
find the required files. Because the contents of the file are constantly confirmed, the hard disk reading is
continuous resulting to high CPU usage rate. Turning off this feature doesn't make it impossible to find the file,
it will only look for the name of the file.

Click on the recording HDD and right click → Properties.
Uncheck the checkbox "Allow files on this drive to have contents indexed in addition to file properties" and
apply all folders and files.

Apply changes to the driver and files.

Note: You can apply the changes to the recording disks.
Note: It is recommended to perform this step before planning the system recording. Otherwise the pressure
on the hard disk will be increased when the disk index is canceled during recording, which indirectly affects
access of the image database from the local or remote.
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Chapter 25.4 Turn off Power Saving Mode
In Windows 7&10 Operating System, press Control Panel→System and Security →Power Option

 Put the computer to sleep: set to Never.
 Turn off hard disk after: set to 0.

Note: Turn off hard disk time setting can effectively reduce hard disk wake up time.

Chapter 25.5 NVIDIA Graphics Card Maximum Performance
If NVIDIA graphic card is use, mouse right click → NVIDIA control panel→ Manage 3D setting→ Global
Settings→ Power management mode→ Prefer maximum performance→ Apply.

Note: If NVIDIA graphic card driver gets updated, it might restore default automatically.
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Chapter 25.6 NVIDIA GeForce Experience
This is used to record and share game videos, and broadcast live on YouTube, Twitch and Facebook.
When installing the graphics card driver, please do not install GeForce Experience. For monitoring system
stability, there is no need for video streaming and frequent automatic driver update

 Please select manually【NVIDIA Graphics Driver】。
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